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Introduction
Thank you for purchasing the Combustion Pressure Analysis Software.
This user’s manual contains useful information about the functions and operating 
procedures of the software (for diesel). To ensure proper use of the software, please read 
this manual thoroughly before beginning operation. After reading the manual, keep it in a 
convenient location for quick reference in the event a question arises.

Notes
•	 The contents of this manual are subject to change without prior notice as a result 

of improvements in the software’s performance and functions. Display contents 
illustrated in this manual may differ slightly from what actually appears on your screen.

•	 Every effort has been made in the preparation of this manual to ensure the accuracy 
of its contents. However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA dealer.

•	 Copying or reproduction of all or any part of the contents of this manual without the 
permission of YOKOGAWA is strictly prohibited.

Trademarks
•	 Microsoft, Internet Explorer, Windows, Windows 7, Windows 8, Windows 8.1, and 

Windows 10 are registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.

•	 Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 
Incorporated.

•	 In this manual, the ® and TM symbols do not accompany their respective registered 
trademark or trademark names.

•	 Other company and product names are trademarks or registered trademarks of their 
respective holders.

Revisions
•	 1st Edition: December 2012
•	 2nd Edition: February 2014
•	 3rd Edition: February 2015
•	 4th Edition: November 2015
•	 5th Edition: October 2017
•	 6th Edition: July 2019

 

6th Edition: July 2019 (YMI)
All Rights Reserved, Copyright © 2012 Yokogawa Test & Measurement Corporation



ii IM 720340-02EN

Overview of This Manual
This manual consists of eight chapters and an appendix as described below.

Chapter Title Description
1 System Configuration Describes the hardware configurations needed for 

applications of the software.
2 Functions Gives an overview of the combustion pressure analysis 

software functions and their flow of operations.
3 Common Operations Describes installation, graph and window operations, and 

the various screens.
4 Monitor Function Gives instructions on how to operate the Measurement 

and Monitor functions.
5 Combustion Pressure 

Analysis Function
Explains operations using the combustion pressure 
analysis function.

6 CSV Files Provides a list of items that are saved to analysis data 
files.

7 Equations Explains how each item is calculated.
8 Error Messages Provides a list of error messages.
Appendix Provides input module information and FAQ.
Index

Conventions Used in This Manual
•	 The following symbols and codes are used in the tables that describe the software’s 

settings and display data.
	 Data Type

C:	Character string
I:	 Integer
F:	Floating point

	 Size

			 

For numerical data
10.2

Number of digits displayed before the decimal point (no. of bytes)

Total number of characters displayed (including the decimal point,
+/- signs, e and E) (no. of bytes)

For character strings
38

Maximum number of bytes

•	 When necessary for clarity, key names of the measuring instrument and items that 
appear on screen are set in boldface.
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1.1	 Hardware Configuration

DL850 Series

SL1000

Actual driving Continuous operation

WDF files

4-cycle/2-cycle engines
Gasoline/Diesel/LPG/LNG engines

EXT-CLK

TRIG

Sensor

Combustion Pressure 
Analysis Software

Analysis 
Function

TDC pulse

Cylinder pressure 
(up to 8 cylinders)

Intake manifold pressure
...

Other signals
Measured data of

DL850 Series/SL1000

Angular pulse
1.0 CA
0.5 CA
0.25 CA
0.1 CA

Engine Dynamo

Ethernet

USB 
interface

3D graph

Cycle graph

Crank angle graph

CSV files
• Numeric analysis
• Crank angle graph
• Cycle graph
• Crank angle graph 
 of all cycles

Numeric analysisP-V graph
Ethernet**

*	 The data that can be analyzed by the analysis function is the wdf data of the data measured 
on the DL850 series/SL1000.

**	 The Ethernet interface is an option on the SL1000. 
***	 WVF data saved with the DL750/WE7000 can also be analyzed offline.

PC System Requirements
OS:	 Windows 7, Windows 8, Windows 8.1, Windows 10
CPU:	 Core 2 Duo 2 GHz or higher
Memory:	 2 GB or more
Hard disk:	2 GB or more of free space

For the DL850 Series/SL1000 (Monitor Function/Analysis Function)
•	 Main Unit

DL850 series/SL1000
(This application does not support synchronized operation of multiple SL1000s.)
Memory length > (no. of cycles to acquire/save + 2) × 1 cycle data length
For 4-cycle engines:	 1 cycle data length = (360/res) × 2
For 2-cycle engines:	 1 cycle data length = (360/res)
res: angular resolution (1, 0.5, 0.25, 0.1)

•	 Input/Output Modules
701251 (High-Speed 1 MS/s, 16-Bit Isolation Module)
	 However, ((RPM/60) × 360/res) < 1 MHz
701261 and 701262 (Universal (Voltage/Temp.) Modules)
	 However, ((RPM/60) × 360/res) < 100 kHz
	 500 Hz is the highest frequency for temperature measurement, but for higher 

frequencies, the same number of points are stored.

Chapter 1	 System Configuration
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2.1 Flow of Operation

Setup

Measurement conditions

TDC correction & calibration factors

Measurement screenFilter conditions

Checking Waveforms
TDC Correction 

Waveform

Save measured data

Setup screen

Measurement 
Conditions screen

Filter Condition 
Setting screen

TDC correction
Calibration factors
Trigger conditions

Monitor screen

Measurement Screen

Calculation screenParameter Settings screen

Parameter Settings 
screen

Analyze combustion 
pressure

Saving measured data

Monitor screen

Calculation screen

Combustion pressure analysis

Setup Wizard

File selection screen

Loading measured data 
(wdf/wvf files)

Monitor Function

Analysis Functions

Save analysis data

Saving analysis data 
(csv files)

Display analysis 
results (raw data, 
crank angle graphs, 
cycle graphs, and 
numeric analysis 
data items)

Display progress of 
acquisition of 
measured data and 
save measured data

Display raw data, 
crank angle graphs, 
and numeric analysis 
data items

Select calculation data 
items and perform 
calculations

Set DL850 series or 
SL1000 interface  
conditions and 
module conditions

Select angular 
resolution, no. of 
measured cycles,
and calculation data 
items when 
monitoring.

Filter ON/OFF,
filter type,
filter orders, etc.

Set engine and
calculation condition 
specifications

Set the TDC 
correction value, 
calibration value 
factors, and trigger 
conditions, and 
check waveform 
conditions

Chapter 2	 Functions
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2.2 Measurement and Monitor Functions

Measurement Function
Using this software, you can enter channel (range, etc.) and trigger conditions on the 
DL850 series/SL1000, and perform measurement.

Trigger Conditions
You can set the trigger source (internal or external), trigger pattern, and level. Also, you 
can display the current waveform by using the Start waveform checking function, allowing 
you to check whether triggers activate per the specified trigger conditions.

Modules on Which Channel Conditions Can Be Set
You can enter the input coupling, range, bandwidth limit, invert waveform setting, and 
other settings on the following input modules.
•	 701251 (High-Speed 1 MS/s, 16-Bit Isolation Module)
•	 701261 and 701262 (Universal (Voltage/Temp.) Modules)
For a list of other supported input modules, see appendix 2.

Monitor Function
You can display the raw data and combustion pressure analysis results for one cycle’s 
worth of data.

Displaying Measured Data (Raw Data)
Displays filtered waveforms for (one cycle’s worth of) measured data before and after 
TDC correction.

Displaying Combustion Pressure Analysis Results
After performing calculations on data after TDC correction, you can display a crank angle 
graph of the results or the numeric analysis data items.

Note
•	 The TDC correction value is set in the TDC Correction and Calibration Factor Setting 

screen.
•	 Trigger conditions are set in the TDC Correction and Calibration Factor Setting screen.

•	 Displayable Analysis Data Items
	 The analysis data items that can be displayed in the crank angle graph and Numeric 

Analysis Data Item screen vary as follows depending on the selected monitor items.

Monitor Item Crank Angle Graph Numeric Analysis Data Item
None Cylinder pressure Maximum cylinder pressure and the corresponding crank angle

P-V graph NMEP
Other signals IMEP

PMEP
dP θ Rate of cylinder pressure rise Maximum rate of cylinder pressure rise and the corresponding crank angle
T θ Cylinder gas temperature Maximum cylinder gas temperature and the corresponding crank angle
dQ θ Rate of heat release Maximum rate of heat release and the corresponding crank angle
Q θ Amount of heat release Maximum amount of heat release and the corresponding crank angle

Combustion mass rate Crank angle at combustion mass rate N1%
Crank angle at combustion mass rate N2%
Crank angle at combustion mass rate N3%
Start point of combustion (point a)
End point of combustion (point b)
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Saving Measured Data (Saving wdf Files)
You can acquire measured data of the number of cycles specified under number of 
cycles to acquire/save (during combustion) in the Measurement Conditions Setting 
screen and save the data in wdf format (Yokogawa proprietary format).

Settings Required for Measurement and Monitoring
Settings in the following setting screens must be entered before using the Measurement 
and Monitor functions.
•	 Setup (section 4.2):
	 Set the number of strokes for the DUT, connected devices, and connected unit (DL850 

series/SL1000)
•	 Measurement conditions (section 4.3):
	 Set the angular resolution, number of cycles to acquire/save, and monitor items (dP θ 

/T θ /dQ θ /Q θ)
•	 Filter settings (section 4.4):
	 Enter digital filter settings
•	 TDC correction and calibration factor settings (section 4.5):
	 Set trigger conditions, calculate the TDC correction value, and enter absolute pressure 

correction and other settings
•	 Detailed module conditions (section 4.6):
	 Set the input coupling, probe, bandwidth limit, and range
•	 Parameter settings (section 4.7):
	 Set parameters for combustion pressure analysis calculations

When initially starting up the DL850 series/SL1000, the Setup Wizard appears and 
presents the above setting screens in order. The Setup Wizard will not appear again 
once settings have been entered initially (the setting conditions can be changed even 
after the Setup Wizard no longer appears upon startup).

Setup Settings
You can set the conditions for connection with the DL850 series/SL1000 and other 
parameters. If this first screen of the Setup Wizard does not appear, click Settings > 
Setup.
The following settings are available.
•	 Number of strokes:	 Select the number of strokes of the engine under test.
•	 Communication device:	�Select the method of communication between the PC running 

the software and the DL850 series/SL1000.
•	 Instrument search:	 Searches for connectable DL850 series/SL1000s.
•	 Units found:			�   Displays a list of connectable DL850 series/SL1000s. Select 

an instrument to connect to, then click Done.
•	 Channel information:	� Displays information about the unit selected in the Units found 

list.

Setting Measurement Conditions
Set the following items.
•	 Angular resolution:	 Select the resolution for displaying graphs.
•	 Number of cycles to acquire/save
	 During motoring:		� Set the number of cycles of measured data to acquire for 

calculation of the TDC correction value.
	 During combustion:	�Set the number of cycles of measured data to save. Used when 

saving measured data.
•	 Monitor items:			�  Select the monitor items. The item under analysis during 

monitoring varies depending on the selected monitor items.

2.2  Measurement and Monitor Functions
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Filter Settings
You can apply filters to raw data. When applying filters, the first cycle’s worth of data is 
always dropped to cancel out the effect of signal rise. The remaining data is treated as 
the raw data and used for rotational offset correction, TDC correction, and combustion 
pressure analysis.
•	 Filter types
	 None, Lowpass, Bandpass, Highpass
•	 Characteristics
	 4th order (24 db/oct) butterworth
•	 Cutoff frequency

•	 At 1 CA resolution, 7.2 order (times) of the number of revolutions (2%) to 72 order 
(times) (20%)

•	 At 0.5 CA resolution, 14.4 order (times) of the number of revolutions (2%) to 144 
order (times) (20%)

•	 At 0.25 CA resolution, 28.8 order (times) of the number of revolutions (2%) to 288 
order (times) (20%)

•	 At 0.1 CA resolution, 72 order (times) of the number of revolutions (2%) to 720 
order (times) (20%)

*	 The percentage in parentheses is the ratio relative to the sampling frequency.
	 % = specified multiple / ( 360 degrees / angular resolution (1, 0.5, 0.25, 0.1) ) ×100
	 For example, to apply a low pass filter with a 1 kHz cutoff:
	 At 3000 rpm (equivalent to 50 Hz),
	 Cutoff = 1 kHz divided by 50 Hz = 20 times the rpm.

The TDC correction value is calculated for the filtered data, and all analyses are 
performed.

Parameter Settings
Enter values for the following parameters required for combustion pressure analysis.

1	 Con-rod Length	 24	Measured fuel consumption
2	 Bore	 25	Number of cylinders
3	 Piston offset	 26	Low heat value
4	 Stroke	 27	Gas constant
5	 Piston head ratio	 28	Suction volumetric efficiency
6	 Clearance volume	 29	Specific gravity
7	 Compression ratio	 30	Cylinder head wall temperature
8	 With/Without supercharging	 31	Cylinder wall temperature
9	 Boost pressure	 32	Piston head wall temperature
10	Supercharger inlet pressure	 33	Exhaust gas pressure
11	Measured supercharger inlet pressure	 34	Measured exhaust gas pressure
12	Supercharger inlet temperature	 35	Exhaust gas temperature
13	Measured supercharger inlet temperature	 36	Measured exhaust gas temperature
14	Boost temperature	 37	Revolutions per minute
15	Presence/absence of heat loss processing	 38	Measured revolutions per minute
16	Start point of combustion	 39	Atmospheric temperature
17	Number of data items for judging start point of 	 40	Measured intake manifold temperature
	 combustion	 41	Atmospheric pressure
18	End point of combustion	 42	Measured intake manifold pressure
19	Number of data items for judging end point of 	 43	Method of absolute pressure correction
	 combustion		  (absolute pressure correction for 
20	Window of searching maximum rate of heat release		 each cycle, and absolute pressure 
21	Ratio for judging angle of combustion mass rate		  correction for cycle average)
22	Value for judging misfire 
23	Fuel consumption

2.2  Measurement and Monitor Functions
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TDC Correction and Calibration Factor Settings
•	 TDC Correction
	 You can perform TDC correction on data measured when motoring.
	 Determines the offset values (calculated TDC correction value, number of engine 

cylinders, and cylinder-to-cylinder TDC correction value) between the TDC pulse 
position and the actual maximum pressure position using the specified number of 
cycles worth of acquired raw data . The offset values can also be entered manually. 
Note that the number of cycles to acquire is set in the Measurement Conditions screen 
as the number of cycles to acquire/save (when motoring).

•	 Absolute Pressure Correction, Calibration Factor (Conversion Coefficients), and 
Other Signals

	 For the signals input to each of the channels (1 to 16), you can set the type (cylinder 
pressure (up to 8 cylinders), intake manifold pressure, intake manifold temperature, 
mass fuel combustion, revolutions per minute, and other signals), range, starting/
ending angle, coefficients for conversion to absolute cylinder pressure, and other 
parameters.

•	 Detailed Module Conditions
	 You can set the input coupling, probe, bandwidth limit, and range for the 701251 

(High-Speed 1 MS/s 16-Bit Isolation Module) and 701261/701262 (Universal (Voltage/
Temp.)Modules).

Correcting Rotational Offset and Calculating the TDC Correction Value
Since rotation pulse (TDC) signals are output once per revolution, there is an offset of 
1/2 cycle for each single cycle of intake, compression, explosion, and exhaust.
Therefore, the crank angle at the maximum point of pressure is determined from within 
one cycle’s worth of data, and if there is a pressure peak on the exhaust or intake stroke, 
the first 1/2 cycle’s worth of data is discarded.

		

Rotation
pulse

Cylinder 
pressure data

If the crank angle at the maximum point of pressure < -180 CA or 
if +180 CA < the crank angle at the maximum point of pressure, 
the rotational offset is set to “yes.” 

Intake

Exhaust

C
om

pre-
ssion

C
om

pre-
ssion

Explosion

Intake

Exhaust

Explosion

Intake

Exhaust

C
om

pre-
ssion

C
om

pre-
ssion

Explosion

Intake

Exhaust

Explosion

Discarded data
Rotational offset: Yes 
(peak on exhaust or 
intake stroke)

Rotational offset: No 
(peak on compression 
or explosion stroke)

Measurement start

For the pressure data from the first cylinder during motoring, the software searches for 
the maximum pressure value after the rotational offset correction is performed, then 
determines the TDC position. It then calculates the offset from the TDC pulse position.
This offset value is used for all analysis thereafter.

2.2  Measurement and Monitor Functions
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•	 TDC Correction Calculation Method
1	 You can compute the average data for all cycles of the cylinder pressure data from 

the motoring data of the first cylinder.

Rotation pulse

Cylinder pressure 
data

Average 
cylinder pressure

1 cycle of data

2	 Using 10 CA’s worth of data before and after the maximum pressure point of 
the averaged cylinder pressure data, you can apply the least square method to 
compute the crank angle of maximum cylinder pressure θX.

3	 The TDC correction value can be determined using θX. The TDC correction value 
is given as the amount of divergence of the maximum pressure point θX from the 
start of measurement, and a correction value is determined such that the position 
of θX is zero (CA).

	 See the figure below.

				  

0θX

0
Discarded data

Measurement start

0

0
θX

0

Data after correction

Data after correction

Discarded data
TDC correction value

TDC correction 
value

2.2  Measurement and Monitor Functions
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Method of Absolute Pressure Correction
You can convert measured cylinder pressure to absolute cylinder pressure. For example, 
cylinder pressure can be corrected so that the average cylinder pressure (on a per 
cycle or all cycle basis) of the crank angle range near BDC (which can be specified by 
the user) equals the atmospheric or intake manifold pressure. You can manually input 
atmospheric pressure (including boost pressure) or use measured intake manifold 
pressure.

Padj

Cylinder pressure
data

Cylinder pressure
data

Pθin1 Pθin2 Pθin3

Pθin1 Pθin2 Pθin3

• When using the per-cycle average value

• When using the all-cycle average value

deg1 deg2

Average 
cylinder pressure

Padj1

deg1 deg2

Padj2

deg1 deg2

Padj3

deg1 deg2

Pressure after absolute pressure correction = Pθinn - Padjn + Pxn
 Pxn: Atomospheric pressure (including boost pressure) or intake manifold pressure

Pressure after absolute pressure correction = Pθinn - Padj + Pxn
 Pxn: Atomospheric pressure (including boost pressure) or intake manifold pressure

Average value across 
the specified crank angle 
range (deg1 to deg2)

Average value across the specified crank angle 
range (deg1 to deg2) at the average of all cycles

Other Signals
You can specify signals that are not to be used for combustion pressure analysis. There 
are no physical units associated with these channels (channels you named “other 
signals”). Please consider these values to have whatever units are appropriate for your 
application. When converting voltage to physical values, enter the conversion coefficients 
(calibration factors) A and B for the equation y=Ax+B. Also, note that absolute pressure 
correction is not performed on these signals.

2.2  Measurement and Monitor Functions
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2.3 Combustion Pressure Analysis Functions

Analyzed Data
Combustion pressure data saved in wdf or wvf format (both are Yokogawa proprietary 
formats) can be analyzed. The maximum number of cylinders that can be analyzed is 8.

Loading Measured Data
The software can load wdf files (Yokogawa proprietary format) containing cylinder data 
measured by the DL850 series/SL1000 from 4- or 2-cycle engines, or wvf files containing 
data measured by the DL750 or WE7000.
After extracting a specified portion of this data (up to 800 cycles worth) for filter 
processing, rotational offset correction, and TDC correction, it can be analyzed.

Filter Settings
You can apply filters (None, Lowpass, Bandpass, or Highpass) to raw data.
For filter processing and filter characteristics, see section 2.2.

Parameter Settings
You can set the calculation parameters used for combustion pressure analysis. For 
details on settings, see section 2.2.

TDC Correction and Calibration Factor Settings
•	 TDC Correction
	 Correction values such as the calculated TDC correction value, number of engine 

cylinders, and cylinder-to-cylinder TDC correction value can be displayed. These 
correction values can be changed or recalculated.

•	 Absolute Pressure Correction and Calibration Factors (Conversion Coefficients)
	 For the signals input to each of the channels (1 to 16), the type (cylinder pressure 

(up to 8 cylinders), intake manifold pressure, intake manifold temperature, mass fuel 
combustion, revolutions per minute, and other signals), range, starting/ending angle, 
coefficients for conversion to absolute cylinder pressure, and other parameters are 
displayed. These settings can be changed.

•	 Other Signals (Channel Names)
	 You can specify signals to be excluded from combustion pressure analysis. Cycle-

averaged values are displayed in the crank angle graph, the average value at each 
cycle is shown in the cycle graph, and the data can be saved in CSV format. TDC 
correction is based on the first cylinder.

For details on rotational offset correction, calculating the TDC correction value, absolute 
pressure correction, and other signals, see section 2.2.
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Manually Input Data Items
You can change the settings and perform combustion pressure analysis of the items below.

Settings Related to TDC Correction and Calibration Factor
•	 TDC correction values	 •	 Conversion coefficients (calibration factors A and B)
•	 Unused channels	 •	 Starting angle of correction interval
•	 Ending angle of correction interval

Settings Related to Parameters
•	 Con-rod length	 •	 Suction volumetric efficiency
•	 Bore	 •	 Revolutions per minute
•	 Piston offset	 •	 Specific gravity
•	 Stroke length	 •	 Boost pressure
•	 Clearance volume	 •	 Exhaust gas pressure
•	 Compression ratio	 •	 Exhaust gas temperature
•	 Method of absolute pressure correction	 •	 Supercharger inlet temperature
•	 Number of data items for judging start 	 •	 Boost temperature
	 point of combustion	 •	 Supercharger inlet pressure
•	 Number of data items for judging end	 •	 Piston head ratio
	 point of combustion	 •	 Cylinder wall temperature
•	 Start point of combustion	 •	 Cylinder head wall temperature
•	 End point of combustion	 •	 Piston head wall temperature
•	 Window for searching maximum rate of 	 •	 Heat release at lowest position
	 heat release	 •	 Presence/absence of supercharging
•	 Fuel consumption	 •	 Presence/absence of heat loss processing
•	 Gas constant	 •	 Ratio for judging angle of combustion mass 
•	 Atmospheric temperature		  rate (3 locations)
•	 Atmospheric pressure	 •	 Value for judging misfire

Selecting Combustion Pressure Analysis Data Items
You can select the items with which to perform combustion pressure analysis from the 
ones below.

Crank Angle Graph
•	Cylinder pressure	 • Rate of cylinder pressure rise	 •	Amount of heat release
•	Rate of heat release	 • Rate of heat release (Received heat)	 •	Rate of heat release (Heat loss)
•	Combustion mass rate	 • Cylinder gas temperature	 •	Polytropic index
•	Ratio of specific heat	 • Other signals

P-V Graph
•	 Cylinder pressure - Piston displacement graph
•	 Logarithmic cylinder pressure - Logarithmic piston displacement graph

Cycle Graph
•	 Maximum cylinder pressure
•	 Averaged maximum cylinder pressure of all cylinders
•	 Crank angle at maximum cylinder pressure
•	 Averaged crank angle at maximum cylinder pressure of all cylinders
•	 Maximum rate of pressure rise
•	 Averaged maximum rate of cylinder pressure rise of all cylinders
•	 Crank angle at maximum rate of cylinder pressure rise
•	 Averaged angle at maximum rate of cylinder pressure rise of all cylinders
•	 NMEP	 •	 Averaged NMEP of all cylinders
•	 IMEP	 •	 Averaged IMEP of all cylinders
•	 PMEP	 •	 Averaged PMEP of all cylinders
•	 Maximum amount of heat release	 •	 Crank angle at maximum amount of heat release
•	 Maximum rate of heat release	 •	 Crank angle at maximum rate of heat release
•	 Crank angle at combustion mass rate N1 %	•	 Crank angle at combustion mass rate N2 %
•	 Crank angle at combustion mass rate N3 %	•	 Other signals

2.3  Combustion Pressure Analysis Functions
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Analysis Data Items Graphed in 3D
•	 Cylinder pressure	 •	 Rate of cylinder pressure rise
•	 Amount of heat release	 •	 Rate of heat release
•	 Rate of heat release (Received heat)	 •	 Rate of heat release (Heat loss)
•	 Combustion mass rate	 •	 Cylinder gas temperature
•	 Polytropic index	 •	 Ratio of specific heat
•	 Other signals

Numeric Analysis Data Items
When performing combustion pressure analysis, you can display a list of the following 
items.
•	 Piston displacement (m3)
•	 Averaged maximum cylinder pressure of all cycles and cylinders (kPa)
•	 Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa)
•	 Averaged NMEP of all cycles and cylinders (kPa)
•	 Averaged IMEP of all cycles and cylinders (kPa)
•	 Averaged PMEP of all cycles and cylinders (kPa)
•	 Minimum IMEP of all cycles and cylinders (kPa)
•	 LNV of IMEP of all cycles and cylinders (kPa)
•	 Average cylinder pressure across correction interval
	 (When calculating the average pressure of the crank angle range determined from the 

all-cycle average and applying the result to all cycles)
•	 Average, standard deviation (kPa), and rate of change (%) of the maximum cylinder 

pressure
•	 Average, standard deviation (kPa), and rate of change (%) of the maximum rate of 

cylinder pressure rise
•	 Average, standard deviation (kPa), and rate of change (%) of NMEP
•	 Average, standard deviation (kPa), rate of change (%), minimum (kPa), and LNV (%) 

of IMEP
•	 Average, standard deviation (kPa), and rate of change (%) of PMEP
•	 Rate of misfire (%)
•	 Average, standard deviation (°C), and rate of change (%) of the maximum cylinder 

gas temperature
•	 Average, standard deviation (J/deg), and rate of change (%) of the maximum rate of 

heat release
•	 Average, standard deviation (J), and rate of change (%) of the maximum amount of 

heat release
•	 Average, standard deviation (CA), and rate of change (%) of the angle at combustion 

mass rate N1%
•	 Average, standard deviation (CA), and rate of change (%) of the angle at combustion 

mass rate N2%
•	 Average, standard deviation (CA), and rate of change (%) of the angle at combustion 

mass rate N3%
•	 Average start point of combustion (point a) (CA)
•	 Average end point of combustion (point b) (CA)
•	 Mass of intake air (kg)
•	 Mass of intake fuel (kg)
•	 Excess air factor
•	 Corrected gas constant
•	 Mass of remaining gas (kg)

2.3  Combustion Pressure Analysis Functions



2-11IM 720340-02EN

Functions

1

2

3

4

5

6

7

8

App

Index

Performing Combustion Pressure Analysis and Displaying Results
•	 Performing Calculations
	 You can perform calculation and analysis on the selected combustion pressure 

analysis data items based on the manually input data item settings (such as 
calculation parameters, TDC correction value, and interval of absolute pressure 
correction).

•	 Displaying Combustion Pressure Analysis Results
	 After performing calculations, you can select one calculated item and display a 

graph (crank angle graph or cycle graph) or display numeric analysis data items in a 
list. Note that manually input data items and analysis data items can be entered or 
reselected so that additional calculations can be performed.

Saving Analysis Data
You can save data of the following items in CSV format (.csv files). Raw data cannot be 
saved.
•	 Test Information
	 Test date/Data name/Testing personnel/Department/Test name/Engine type/Serial 

No./Place of test/Test bench type/Comments
•	 Manually Input Data Items (for details, see above).
•	 Numeric Analysis Data Items (for details, see above).
•	 Crank Angle Graph Data
•	 Cycle Graph Data
•	 Analysis Data for Other Signals
•	 Measured Intake Manifold Pressure, Intake Manifold Temperature, Fuel Consumption, 

Exhaust Gas Pressure, Exhaust Gas Temperature, Supercharger inlet pressure, 
Supercharger inlet temperature, and Revolutions per Minute (only when measured)

Saving Analysis Data (of a Specified Range of Cycles)
For the ten items below, the crank angle graph data from a specified range of cycles can 
be saved in CSV format (as .csv files).

•	 Cylinder pressure	 •	 Logarithmic cylinder pressure
•	 Rate of cylinder pressure rise	 •	 Cylinder gas temperature
•	 Amount of heat release	 •	 Rate of heat release
•	 Rate of heat release (received heat)	 •	 Rate of heat release (heat loss)
•	 Combustion mass rate	 •	 Ratio of specific heat

Loading and Saving Analysis Conditions
The following analysis conditions can be saved (as .ecp files) in text format and loaded.

•	 TDC correction value	 •	 Number of cylinders
•	 Interval of absolute pressure correction
•	 Coefficients for conversion to physical values (calibration factors)
•	 Filter setting conditions	 •	 Calculation parameters
•	 Calculation execution items	 •	 Analysis graph display conditions
•	 Screen layout

2.3  Combustion Pressure Analysis Functions
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3.1	 Installing and Starting the Software

Installing the Software
Use the setup program on the CD to install (set up) the Combustion pressure analysis 
software.
Run the file, CD Drive:\Setup.exe.
You must log in as the administrator to perform the installation. For details, see the 
separate user’s manual.

Starting the Program
Connect the hardware license key to a USB port.

Click the  icon for the combustion pressure analysis software on the desktop. The 

Combustion pressure analysis software starts.

Uninstallation
Select "Combustion Pressure Analysis Software" from "Programs and Features" on 
"Control Panel".
Click Uninstall..

Chapter 3	 Common Operations
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3.2	 Screens

Startup Screen
Monitor function active Distinguishes between raw data (v) 

and corrected data (v)

Differences between the Monitor and Analysis Screens

		

Displays the file name

Displays “Monitor”

Analysis screen

Monitor screen

Menu Bar and Toolbar

Toolbar
Menu bar

10987654321

1 2 64, 5 11. Moves the 
cursor

8 10

1. Saves measured data
5. Performs calculations

12. Saves bitmap data

4 7

1. Setup Wizard
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Menu Bar Toolbar Explanation
1 File

Load measured data  *1, 2 Loads wdf/wvf files containing data measured by 
the DL850 series, SL1000, DL750, or WE7000.

Save measured data  *1 Acquires the specified number of cycles worth of 
data measured during monitoring and saves it to 
a file (wdf data).

Save analysis data  *2 Saves data analyzed with the analysis functions 
to a file (csv format).

Load analysis conditions  *1, 2 Loads files to which test information, manually 
input data items, calculation data items, and 
other items were saved.

Save analysis conditions  *1, 2 Saves test information, manually input data 
items, calculation data items, and other items.

Setup Wizard  *2 Displays the Monitor and Setup screens. You 
can use the wizard when nothing is displayed 
in the combustion pressure analysis software 
window.

Close - Closes the active window and all other 
associated windows.

Exit application - Exits the program.
2 Edit

Undo -
Cut

Copy

Paste

3 View
Measured data*1, 2 - Displays measured (raw) data before or after 

TDC correction.
Crank angle graph*1, 2 - Displays a crank angle graph.
Cycle graph*1, 2 - Displays a cycle graph (only when using the 

analysis function).
Numeric analysis data 
item*1, 2

- Displays a list of analysis results

4 Settings
Setup  *1 Displays the Setup screen (the first screen of the 

Setup Wizard). You can set the conditions for 
connection with the DL850 series/SL1000 and 
other parameters.

Measurement conditions  *1 Sets measurement conditions (angular 
resolution, number of cycles to acquire/save, 
etc.).

Filter  *1, 2 Sets filter conditions.

TDC correction and 
calibration factor setting

 *1, 2 Sets TDC correction and the calibration factor.

5 Calculation
Set parameters  *1, 2 Sets the parameters used for performing 

combustion pressure analysis.
Calculate  *2 Selects the items of analysis and performs the 

calculation.
6 Monitor

Start  *1 Starts the monitor.

Stop  *1 Stops the monitor.

*1	 Available when using the Monitor function
*2	 Available when using the Combustion Pressure Analysis function

3.2  Screens
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Menu Bar Toolbar Explanation
7 Graph

3D graph  *2 Enters 3D graph related settings.

Axis range  *1, 2 Sets the scales of the X and Y axes.

Displayed channels*1, 2 - Selects the channels to be displayed in the 
graph.

Cycles  *2 Sets the number of cycles to display in the crank 
angle graph.

Graph colors  *1, 2 Sets the colors of the graph.

8 Window
Cascade -
Tile -
Arrange icons -
Minimize

Restore

9 System
Environment settings*1, 2 - Sets the operating conditions.

10 Help*1, 2

Help  *3 Opens the user’s manual in pdf format.

About ECP - Displays the software version.
11 -  *1, 2 Moves the cursor to the right or left when 

displaying a graph.
12 -  *1, 2 Saves the image as a bitmap file.

*1	 Available when using the Monitor function
*2	 Available when using the Combustion Pressure Analysis function
*3	 To view PDF files, you need Adobe Reader.

3.2  Screens
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3.3	 Graph Operations

If you right-click on a window displaying a graph, the following shortcut menu appears, 
and  following operations can be performed.

			 

Monitor screen Analysis screen

•	 Measured data:
	 Opens a new window displaying a crank angle graph of raw data (data after TDC 

correction).
•	 Crank angle graph:
	 Opens a new window displaying a crank angle graph of selected analysis data items.
•	 Cycle graph:
	 Opens a new window displaying a cycle graph of selected analysis data items. Note 

that this operation is not available when using the Monitor function.
•	 Numeric analysis data items:
	 Opens a window displaying calculated numeric analysis results.
•	 3D graph:
	 Displays the Graph Dimension Settings screen. Selects 2D or 3D graph, and sets 

3D graph conditions (when displaying a crank angle graph or 3D analysis graph).
	 The range of cycles extracted from the raw data is set as the maximum range, crank 

angle data is extracted every number of cycles specified by “by,” and the data is 
displayed in a 3D graph (displays up to 20 waveforms). Note that this operation is not 
available when using the Monitor function.

			 

•	 Axis range:
	 Displays the Axis Settings screen. You can set a fixed value for the X and Y axes, or 

choose Autoscale. These settings are entered for each graph.

			 

•	 Display channels:
	 Displays a pull-down menu for display channels. This setting is entered for each 

graph.
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•	 Cycles:
	 Displays a setting screen for the Displayed Cycles. These settings are entered for 

each graph.

			 

AVE:		 Displays a cycle average crank angle graph
ALL:		  Displays superimposed crank angle graphs of all cycles
Other:	 Displays a crank angle graph of the specified cycles

•	 Graph colors:
	 Displays the Graph Color Setting screen. These settings are entered for each graph.

			 

AVE:		 Displays a cycle average crank angle graph
ALL:		  Displays superimposed crank angle graphs of all cycles
Other:	 Displays a crank angle graph of the specified cycles

			 

•	 Move cursor:
	 Reads the cursor position directly. Cursors can be moved from left to right in units of 

angular resolution using the following buttons.
 :	Fast left cursor
 :	Left cursor
 :	Right cursor
 :	Fast right cursor

•	 Displaying the Mouse Pointer Position:
	 When the mouse is moved over a graph, the X and Y value of the current position is 

displayed on the graph.

•	 Save screen to BMP file:
	 Click  to save the active graph window as a bitmap file.

•	 Show help:
	 Click Help > Help, or click the  button to display the user’s manual in pdf format. 

You can also click Help > About ECP to display version information.

3.3  Graph Operations
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3.4	 Window Operations

Functions
The window operations below can be performed. You can select these from the menus 
bar Window, or click the corresponding icon.
Cascade:	 Arranges all open windows in a cascading fashion.
Tile:	 Arranges all open windows so that they do not overlap.
Arrange icons:	 Arranges minimized icons.
Minimize:	 Minimizes all windows accessing the same data.
	 Minimizes all real time monitor function windows.
Restore:	 Restores all minimized windows that were accessing the same data.
	 Restores all minimized real time monitor function windows.

•	 Closing Windows
	 You can close a window with either of the procedures below.

•	 Click the close button (×) in the upper right corner of the active window.
	 The active window closes.
•	 On the menu bar, click File > Close.
	 All windows accessing the data files used for the current window are closed. The 

current analysis results are discarded at the same time.
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3.5	 Environment Settings

		

Click System > Environment settings

Functions
You can change the operating conditions of the combustion pressure analysis software. 
Edit settings in the screen that is displayed when you click System > Environment 
settings.

Setting/Display Data
Combustion pressure analysis software operating conditions
•	 Startup in Analysis mode: 	� Select to bypass the Setup Wizard and display the file 

loading screen for the combustion pressure analysis. 
•	 Show wizard upon startup:	Select to start the Setup Wizard. 

Note that the operation differs depending on the Startup in Analysis mode setting as 
follows. 

Startup in 
Analysis Mode

Show Wizard 
upon Startup

Operation upon Startup

ON ON Displays the combustion pressure analysis screen
ON OFF Displays the combustion pressure analysis screen
OFF ON Opens the Setup Wizard
OFF OFF Opens a startup confirmation message*1 or displays the 

monitor screen*2

*1	 If the condition of the hardware upon startup differs from the previous session
*2	 If the condition of the hardware upon startup is the same as the previous session

Button Operations
OK:	� Enters set conditions and exits. To change conditions, you must restart the 

combustion pressure analysis software.
Cancel:	 Discards setting conditions and exits.
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4.1	 Starting the Setup Wizard

When Starting the Combustion Pressure Analysis Software
Perform one of the following operations.
•	 A startup confirmation message appears immediately after installation or if the 

previous measurement setting conditions and hardware conditions (connection 
conditions) are different.

•	 If the measurement setting conditions match the previous conditions, the Monitor 
screen opens and monitoring starts.

•	 If you selected Start up in Analysis Mode in the Environment Settings screen, a file 
selection screen opens.

Setup Wizard
The Setup Wizard takes you through the various setting screens, in order, that are 
described in sections 4.2 through 4.7. Using the wizard allows you to systematically enter 
all of the settings required for measurement and monitoring. For details on each setting 
screen, see sections 4.2 to 4.7.
Note that you can display the Setup screen (the first screen of the wizard) by clicking 
Settings > Setup.

		

Click No when performing combustion pressure analysis or when not using the 
Measurement Setup Wizard.

Note
•	 To perform only analysis with data saved to the PC, click No.
•	 If you select the Display wizard on startup check box, the setup wizard will always appear 

upon startup. However, the wizard will not appear if you specify to start up for combustion 
pressure analysis in the system settings.

•	 The Show wizard upon startup setting can be changed in the environment settings screen 
(section 3.5). 

Chapter 4	 Monitor Function Startup
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4.2	 DL850 Series/SL1000 Connection Settings 
(Setup screen)

		

Click Settings > Setup, or click .

Functions
•	 Sets the interface for communication between the SL1000 or DL850 series and the 

PC, as well as various conditions for the interface.
•	 Searches for measurement instruments connected to the PC through the specified 

interface.
•	 If you click one of the measurement iinstruments found, a list of input modules 

mounted on that measurement iinstrument is generated.
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Setting/Display Data
No. Item Default  

Setting
Data  
Type

Size Numerical Data
Min. Value Max. Value

1 Measuring Instrument 
Selection

Prev. value

2 No. of Strokes Prev. value - - - -
3 Communication Device Prev. value
4 DL850 series: Serial No. Prev. value
5 DL850 series: IP Address Prev. value
6 Group ID Prev. value - - - -
7 SL1000:Unit Address Prev. value - - - -
8 SL1000:IP Address Prev. value I 16 - -
9 Connected Units Prev. value - - - -
10 Channel Information

ID Prev. value - - - -
Channels Prev. value - - - -
Modules Prev. value - - - -

1	 Measuring Instrument Selection:	 Select DL850 series or SL1000.
2	 No. of Strokes:	 Select 2-cycle or 4-cycle engine.
3	 Communication Device:	 Select Ethernet or USB.
4	 Instrument Search
	 DL850 series:
		  Serial No.:	� If you select USB, set the DL850 series serial 

number. For the serial number, see the install 
manual (IM 720340-04EN.)

	 IP address:	 If you select Ethernet, set the DL850 series IP 
address.

	 SL1000 Group ID:	� Select an area group number for the SL1000 
from 0 to F and Not Specified. If you select “Not 
Specified,” all units on the communication device 
will be searched for.

	 Unit Address:	 Select Auto Search or Specify Address.
			�   If you select Specify Address, enter an IP address.
9	 Connected Units:	� Icons are displayed for the instruments that are 

found in the search.
		�  If you click one of the found instruments, a list of 

input modules installed in the instrument will be 
created.

		�  If the same units are not present, or if the module 
list is not the same the next time you start the 
software, the Setup Wizard will appear.

Button Operations
Search:	� Searches for SL1000s based on specified conditions, and displays an icon for 

each connected unit found. The units displayed are the master units for their 
group.

Back:	 Cannot be selected.
Next:	 Saves settings and moves to the Measurement Conditions Setting screen.
Exit:	 Saves settings and closes the screen.
Cancel:	 Discards settings and closes the screen.

4.2  DL850 Series/SL1000 Connection Settings (Setup screen)
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4.3	 Setting Measurement Conditions 
(Measurement Conditions Setting screen)

		

Click Settings > Measurement conditions, or click 

Functions
You can set the following items.
•	 Angular resolution:	� Select a horizontal axis resolution for graphs of 1 CA, 0.5 CA, 

0.25 CA, or 0.1 CA.
•	 Number of cycles to acquire/save
	 During motoring:		� Sets the number of cycles of measured data to acquire for 

calculation of the TDC correction value.
	 During combustion:	� Sets the number of cycles of measured data to save. Used 

when saving measured data.
•	 Select monitor items:	� Select the monitor items. The analysis data items that can 

be displayed in the crank angle graph and Numeric Analysis 
Data Item screen vary as in the table below depending on the 
selected monitor items.

Note
The settings take effect after monitoring is resumed.

Displayable Analysis Data Items
Monitor Items Crank Angle Graph Numeric Analysis Data Item
None Cylinder pressure Maximum cylinder pressure and the 

corresponding crank angle
P-V graph NMEP
Other Signals IMEP

PMEP
dP θ* Rate of cylinder pressure rise Maximum rate of cylinder pressure rise and 

the corresponding crank angle
T θ* Cylinder gas temperature Maximum cylinder gas temperature and the 

corresponding crank angle
dQ θ* Rate of heat release Maximum rate of heat release and the 

corresponding crank angle
Q θ* Amount of heat release Maximum amount of heat release and the 

corresponding crank angle
Combustion mass rate Crank angle at combustion mass rate N1%

Crank angle at combustion mass rate N2%
Crank angle at combustion mass rate N3%
Start point of combustion (point a)
End point of combustion (point b)

*	 The analysis data items when no monitor items are selected (None) are also targeted for 
analysis/display.



4-5IM 720340-02EN

M
onitor Function Startup

1

2

3

4

5

6

7

8

App

Index

Setting/Display Data
No. Item Default 

Setting
Data 
Type

Size Numerical Data
Min. Value Max. Value

1 Angular resolution Prev. value - - - -
2 Number of cycles to acquire/save Prev. value I 3.0 2 See Appendix 1
3 Select monitor items Prev. value - - - -

Button Operations
Back:	 Saves settings and returns to the Setup screen.
Next:	 Saves settings and moves to the Filter Conditions screen.
Exit:	 Saves settings and closes the screen.
Cancel:	 Discards settings and closes the screen.

4.3  Setting Measurement Conditions (Measurement Conditions Setting screen)
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4.4	 Setting Filter Conditions (Filter Conditions 
Screen)

		

Click Settings > Filters, or click 

Functions
•	 You can perform digital filter processing on raw data. If the raw data has already been 

displayed and filter settings are changed, filters are automatically reapplied and the 
display is updated.

	 However, this does not affect current analysis results. All analysis results are 
discarded, and any currently displayed analysis results windows (crank angle graphs 
or numeric analysis data items) are forcibly closed.

	 After recalculation, display the analysis results window.
•	 You can select a filter of None, Lowpass, Bandpass, or Highpass.
•	 The filter function is a 4th order Butterworth (24 db/oct).
•	 The cutoff frequency is set in numbers of orders (multiples) since data acquisition 

uses synchronization with the rotation pulse.
•	 When filters are applied, any TDC correction and combustion pressure analysis 

performed thereafter is done on filtered data.

Setting/Display Data
No. Item Default  

Setting
Data  
Type

Size Numerical Data
Min. Value Max. Value

1 Filter type Prev. value - - - -
2 Cutoff Prev. value F 6.1 7.2 720

1	 Filter type:	Select a filter of None, Lowpass, Bandpass, or Highpass.
2	 Cutoff:		�  At 1 CA resolution, 7.2 order (times) to 72 order (times) of the number 

of revolutions
					�     At 0.5 CA resolution, 14.4 order (times) to 144 order (times) of the 

number of revolutions
					�     At 0.25 CA resolution, 28.8 order (times) to 288 order (times) of the 

number of revolutions
					�     At 0.1 CA resolution, 72 order (times) to 720 order (times) of the number 

of revolutions

Button Operations
Back:	 Saves settings and returns to the Measurement Conditions screen.
Next:	� Saves settings and moves to the TDC Correction and Calibration Factor Setting 

screen.
Exit:	 Saves settings and closes the screen.
Cancel:	 Discards settings and closes the screen.
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4.5	 Setting TDC Correction and the Calibration 
Factor

	

Displays the Waveform 
Checking screen.

Acquires data of the number of cycles specified under “number of cycles to 
acquire/save” in the Measurement Condition Setting screen (opened by clicking 
Settings > Measurement Conditions) and calculates the correction value.

Click Settings > TDC correction and calibration factor, or click 

Functions
•	 The TDC correction value can be calculated using one cycle’s worth of all-

cycleaveraged motoring data from cylinder 1 (P1).
	 The calculated TDC correction value is added to the difference in angle between 

cylinders according to the specified number of cylinders (for example at 4 cycles 
and 4 cylinders) in the following manner: 0 + calculated TDC correction value, 180 
+ calculated TDC correction value, 360 + calculated TDC correction value, 540 + 
calculated TDC correction value, then the cylinder-to-cylinder TDC correction value is 
automatically set.

	 You can also set the cylinder-to-cylinder TDC correction values manually (excluding 
P1).

•	 Signal assignments can be entered.
	 You can assign channels to cylinder pressure (up to eight cylinder’s worth), intake 

manifold pressure, intake manifold temperature, fuel consumption, rpm, exhaust gas 
pressure, exhaust gas temperature, supercharger inlet pressure, supercharger inlet 
temperature, and other signals.

•	 The cylinder pressure signals undergo TDC correction per the specified TDC 
correction value.
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•	 Cylinder pressure measurements take place in the cylinder’s firing order, with the 
assumption that all signals are assigned to contiguous channels starting with channel 1.

•	 You can specify channels to be excluded from combustion pressure analysis.
•	 If raw data is already displayed, settings are automatically applied and the display is 

updated. However, this does not affect current analysis results. When changing these 
settings, all previously calculated analysis results are discarded, and any currently 
displayed analysis results windows (crank angle graphs or numeric analysis data 
items) are forcibly closed. After recalculation, display the analysis results window.

•	 You can enter trigger condition settings. With CH level triggers, you can enter level 
settings with the waveform checking function.

	 If the trigger does not activate properly, you can use a manual trigger to check the 
waveform.

•	 You can acquire data for calculating the TDC correction value (data acquisition when 
motoring), and use that waveform for obtaining TDC correction results.

Setting/Display Data
No. Item Default  

Setting
Data 
Type

Size Numerical Data
Min. Value Max. Value

1 Calculated TDC Correction 
Value

Calculated value F 7.2 *1 *2

2 Number of Cylinders Prev. value I 2.0 1 8
3 Cylinder-to-cylinder TDC 

Correction
Calculated value F 7.2 *1 *3

4 Ch Selection None - - - - 
5 Channel Name None - - - - 
6 Interval of Absolute Pressure 

Correction
Prev. value F 7.2 *1 *2

7 A Prev. value F 8.2 1 99999.99
8 B Prev. value F 8.2 1 99999.99
9 Trigger conditions Prev. value
10 Edge Prev. value - - - -
11 CH select Prev. value - - - -
12 Level Prev. value F 5.2 -999.99 999.99

*1:	4 cycles = -360; 2 cycles = -180
*2:	4 cycles = -359.9; 2 cycles = -179.9
*3:	4 cycles = -1079.9; 2 cycles = -539.9

1	 Calculated TDC Correction Value:
	 Displays the TDC correction values calculated using the average of all cycles of the 

first cylinder (P1). The value can also be entered manually. When the OK button is 
used, this value is rounded to the angular resolution and applied to each channel.

2	 Number of Cylinders:
	 Specified for automatic calculation of the cylinder-tocylinder correction value. If the 

value is changed, click the Calculate button to recalculate the results.
3	 Cylinder-to-cylinder TDC Correction:
	 The calculated TDC correction value is added to the difference in the crank angle. 

For example, with a 4-cycle engine:
	 4 cylinders = 180 CA, 6 cylinders = 120 CA, and 8 cylinders = 90 CA. You can also 

set the value manually (excluding P1).
4	 Ch Selection
	 Selected channels are targeted for combustion pressure data measurement and 

analysis, and for saving in csv format. 

4.5  Setting TDC Correction and the Calibration Factor
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5	 Channel Names:
	 Signals are assigned to channels 1 through 16. Select the signal type from the 

options below.
	 P1 to P8:	 Cylinder pressure in the order of firing
	 Pitk:			   Intake manifold pressure
	 Gfuel:		  Fuel consumption
	 Ne:			   Revolutions per minute
	 Td:			   Intake manifold temperature
	 Pex:			   Exhaust gas pressure
	 Tex:			   Exhaust gas temperature
	 Pturbin:		 Supercharger inlet pressure
	 Tturbin:		  Supercharger inlet temperature
	 Other:		  Other Signals
	 For signals other than P1 through P8, TDC correction is performed based on the 

1st cylinder.
	 This measured data can be used when measuring intake manifold pressure, 

fuel consumption, revolutions per minute, intake manifold temperature, Exhaust 
gas pressure, Exhaust gas temperature, Supercharger inlet pressure, and 
Supercharger inlet temperature and performing analysis. The average value at 
each cycle can be saved to a .csv file.

	 Other signals can be displayed in a crank angle graph or cycle graph, and that 
graphical data can be saved in CSV format.

7	 A, B:	
	 The measured voltage signals are converted to physical values using the equation 

y = Ax + B
9	 Trigger conditions:
	 Select External trigger or CH level trigger. For external triggers, select rising or 

falling edge. For CH level triggers, specify a channel number, level, and edge.

Button Operations
Start measurement of TDC correction data:
	� Measures motoring data and calculates the TDC correction value. 

The measured number of cycles is the value specified for the number 
of cycles during motoring in the measurement condition settings. A 
progress bar is displayed during measurement.

Start waveform checking:
	� Opens the Waveform checking screen. You can check whether the 

range and trigger conditions are set correctly. Note that if trigger 
conditions are not set correctly, a waveform is not displayed. If you 
click Manual trigger a trigger is forcibly activated, allowing you to 
check the waveform. Reenter the range and trigger conditions, making 
sure they are correct. If you click the Start waveform checking key, 
it changes to the Stop waveform checking key. Waveform checking 
involves repeating cycles of data measurement and waveform display. 
After checking the waveforms, you can change the display channel and 
move the cursor on the last-displayed waveform to check values.

Manual trigger:	� Opens the Waveform Checking screen. Forcibly activates a trigger and 
displays the waveform on screen.

Detailed settings:	�For the 701251 and 701261/701262 modules, moves to the Detailed 
Settings screen.

Back:	 Saves settings and returns to the Filter Settings screen.
Next:	� Saves settings and moves to the Parameter Setting screen.
Exit:	 Saves settings and closes the screen.
Cancel:	 Discards settings and closes the screen.

4.5  Setting TDC Correction and the Calibration Factor
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4.6	 Setting Channel Conditions for the Input 
Module (Detailed Setting Screen)

701251

		

Click Settings > Channel conditions in the TDC Correction and Calibration Factor screen 
> Detailed settings

Setting/Display Data
No. Item Units Default 

Setting
Data 
Type

Size Numerical Data
Min. Value Max. Value

1 Channel number - - - - - -
2 Input coupling - Prev. value - - - -
3 Probe - Prev. value - - - -
4 Bandwidth limit - Prev. value - - - -
5 Range - Prev. value - - - -
6 Invert waveform - Prev. value - - - -

2	 Input coupling:		  Sets the coupling information of the signal to connect.
								        Select AC, DC, or GND. Default value: DC
3	 Probe information:	 Select 1:1, 10:1, 100:1, 1000:1, 10A:1, or 100A:1.
4	 Bandwidth limit:		  Select a limit from the box.
								        Select 400 Hz, 4 kHz, 40 kHz, or Full.
5	 Range:					     Select a limit from the box.
								        The setting range varies depending on the probe information.
								        V/div	 Voltage range
								        2 mV/div to 40 V/div	 10 mV to 200 V (1:1)
								        20 mV/div to 400 V/div	 100 mV to 2 kV (10:1)
								        200 mV/div to 4 KV/div	 1 V to 20 kV (100:1)
								        2 V/div to 40 KV/div	 10 V to 200 kV (1000:1)
								        20 mA/div to 400 A/div	 100 mA to 2 kA (10 A:1 V  0.1 V/A)
								        200 mA/div to 4 KA/div	 1 A to 20 kA (100 A:1 V  0.01 V/A)
6	  Invert waveform:	 Selects whether or not to invert the waveform on screen.

Button Operations
Previous channel:	 Saves settings and moves to the previous detailed conditions screen.
Next channel:	 Saves settings and moves to the next detailed conditions screen.
Exit:	 Saves settings and closes the screen.
Cancel:	� Discards settings and closes the screen.
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701261

		

Click Settings > Channel conditions in the TDC Correction and Calibration Factor screen 
> Detailed settings

Setting/Display Data
No. Item Units Default 

Setting
Data 
Type

Size Numerical Data
Min. Value Max. Value

1 Channel number - - - - - -
2 Input coupling - Prev. value - - - -
3 Probe - Prev. value - - - -
4 Bandwidth limit - Prev. value - - - -
5 Range - Prev. value - - - -
6 Invert waveform - Prev. value - - - -

2	 Input coupling:	 Select AC, DC, TC, or GND.
3	 Bandwidth limit:	� If voltage is selected under input coupling, select 40 Hz, 400 Hz, 

4 kHz, or Full, and if thermocouple (TC) is selected, select 2 Hz, 
8 Hz, 30 Hz, or Full.

4	 Range:				�    Select a limit from the box. If the input coupling is AC, DC, or 
GND, select from 10 mV/div to 40 V/div (50 mV to 200 V), and 
if TC, select K, E, J, T, L, U, N, R, S, B, W, or iron doped gold/
chromel (Au7Fe).

5	 Invert waveform:	�Selects whether or not to invert the waveform on screen. Can only 
be set if AC, DC, or GND is selected under input coupling. Can be 
set if TC is selected.

6	 TC Units:			   If the input coupling is TC, select °C, K or F.
7	 RJC:					    Select RJC.
8	 Burnout:			�   Selects whether or not to perform a burnout check. Can only be 

set if TC is selected under input coupling. Cannot be set if AC, 
DC, or GND is selected.

Button Operations
Previous channel:	 Saves settings and moves to the previous detailed conditions screen.
Next channel:	 Saves settings and moves to the next detailed conditions screen.
Exit:	 Saves settings and closes the screen.
Cancel:	� Discards settings and closes the screen.

4.6  Setting Channel Conditions for the Input Module (Detailed Setting Screen)
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701262

		

Click Settings > Channel conditions in the TDC Correction and Calibration Factor screen 
> Detailed settings

Setting/Display Data
No. Item Units Default 

Setting
Data 
Type

Size Numerical Data
Min. Value Max. Value

1 Channel number - - - - - -
2 Input coupling - Prev. value - - - -
3 Probe - Prev. value - - - -
4 Bandwidth limit Prev. value - - - -
5 Range - Prev. value - - - -
6 Invert waveform - Prev. value - - - -

2	 Input coupling:	 Select AC, DC, TC, or GND.
3	 Bandwidth limit:	� If voltage is selected under input coupling, select 40 Hz, 400 Hz, 

4 kHz, or Full, and if thermocouple (TC) is selected, select 2 Hz, 
8 Hz, 30 Hz, or Full.

4	 Range:				�    Select a limit from the box. If the input coupling is AC, DC, or 
GND, select from 10 mV/div to 40 V/div (50 mV to 200 V), and 
if TC, select K, E, J, T, L, U, N, R, S, B, W, or iron doped gold/
chromel (Au7Fe).

5	 Invert waveform:	�Selects whether or not to invert the waveform on screen. Can only 
be set if AC, DC, or GND is selected under input coupling. Can be 
set if TC is selected.

6	 TC Units:			   If the input coupling is TC, select °C, K or F.
7	 RJC:					    Select RJC.
8	 Burnout:			�   Selects whether or not to perform a burnout check. Can only be 

set if TC is selected under input coupling. Cannot be set if AC, 
DC, or GND is selected.

Button Operations
Previous channel:	 Saves settings and moves to the previous detailed conditions screen.
Next channel:	 Saves settings and moves to the next detailed conditions screen.
Exit:	 Saves settings and closes the screen.
Cancel:	� Discards settings and closes the screen.

4.6  Setting Channel Conditions for the Input Module (Detailed Setting Screen)
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4.7	 Setting Calculation Parameters (Parameter 
Settings Screen)

		

Click Settings > Parameters, or click 

Functions
•	 You can enter the engine type and other parameters necessary for combustion 

pressure analysis.
•	 You can select either Clearance volume or Compression ratio.
•	 Enter the number of data to be used when searching for the start and end of 

combustion through calculation. You can also specify the start and end points of 
combustion directly.

•	 Specify the range for searching for the maximum rate of heat release.
•	 Select the method of absolute pressure correction.
•	 Select whether or not to use this measured data for analysis when measuring 

intake manifold pressure, fuel consumption, revolutions per minute, intake manifold 
temperature, exhaust gas pressure, exhaust gas temperature, supercharger inlet 
pressure, and supercharger inlet temperature (see numbers 11, 13, 24, 34, 36, 38, 40, 
and 42 in the table on the next page).

•	 When changing these settings, all previously calculated analysis results are discarded, 
and any currently displayed analysis results windows (crank angle graphs or numeric 
analysis data items) are forcibly closed.

	 After recalculation, display the analysis results window.
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Setting/Display Data
No. Item Unit Default 

Setting
Data 
Type

Size Numerical Data
Min. Value Max. Value

1 Con-rod Length mm Prev. value F 9.3 0.000 99999.999 
2 Bore mm Prev. value F 9.3 0.000 99999.999 
3 Piston offset mm Prev. value F 9.3 -99999.999 99999.999 
4 Stroke mm Prev. value F 9.3 0.000 99999.999 
5 Piston head ratio - Prev. value F 9.3 0.000 99999.999 
6 Clearance volume cm3 Prev. value F 9.3 0.000 99999.999 
7 Compression ratio - Prev. value F 6.3 0.000 99.999 
8 With/Without supercharging - Prev. value - - - -
9 Boost pressure kPa Prev. value F 9.3 0.000 99999.999 
10 Supercharger inlet pressure kPa Prev. value F 9.3 0.000 99999.999 
11 Measured supercharger inlet 

pressure
- - - - - -

12 Supercharger inlet temperature °C Prev. value F 9.3 -273.000 99999.999 
13 Measured supercharger inlet 

temperature
- - - - - -

14 Boost temperature °C Prev. value F 9.3 -273.000 99999.999 
15 Presence/absence of heat loss 

processing
- - - - - -

16 Start point of combustion CA Prev. value F 6.2 -360.000 359.99 
17 Number of data items 

for judging start point of 
combustion

- Prev. value I 2.0 3 99 

18 End point of combustion CA Prev. value F 6.2 -360.000 359.99
19 Number of data items 

for judging end point of 
combustion

- Prev. value I 2.0 3 99 

20 Window of searching maximum 
rate of heat release

CA Prev. value F 6.2 -360.000 359.99 

21 Ratio for judging angle of 
combustion mass rate

% Prev. value I 2.0 5 95

22 Value for judging misfire kPa Prev. value F 9.3 0.000 99999.999 
23 Fuel consumption cm3/s Prev. value F 9.3 0.000 99999.999 
24 Measured fuel consumption - - - - - -
25 Number of cylinders - Prev. value I 1.0 1 8 
26 Low heat value J/kg Prev. value I 9 0 999999999 
27 Gas constant

(× 9.80665 J/kg.K)
- Prev. value F 9.3 0.000 99999.999 

28 Suction volumetric efficiency % Prev. value F 9.3 0.000 99999.999 
29 Specific gravity - Prev. value F 9.3 0.000 99999.999 
30 Cylinder head wall temperature °C Prev. value F 9.3 0.000 99999.999 
31 Cylinder wall temperature °C Prev. value F 9.3 0.000 99999.999 
32 Piston head wall temperature °C Prev. value F 9.3 0.000 99999.999 
33 Exhaust gas pressure kPa Prev. value F 9.3 0.000 99999.999 
34 Measured exhaust gas 

pressure
- - - - - -

35 Exhaust gas temperature °C Prev. value F 9.3 0.000 99999.999 
36 Measured exhaust gas 

temperature
- - - - - -

37 Revolutions per minute rpm Prev. value I 5.0 0 99999 
38 Measured revolutions per 

minute
- - - - - -

39 Atmospheric temperature °C Prev. value F 9.3 -273.000 99999.999 
40 Measured intake manifold 

temperature
- - - - - -

41 Atmospheric pressure kPa Prev. value F 9.3 0.000 99999.999 
42 Measured intake manifold 

pressure
- - - - - -

43 Method of absolute pressure 
correction

- - - - - -

4.7  Setting Calculation Parameters (Parameter Settings Screen)
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16	Start point of combustion: The specified value (without searching).
18	End point of combustion: The specified value (without searching).
20	Window of searching maximum rate of heat release:
	 Set the range for finding the maximum angle of the rate of heat release used as the 

standard for searching for the start and end points of combustion.
21	Ratio for judging angle of combustion mass rate:
	 Determines the crank angle at which the combustion mass rate matches the 

specified percentage.
22	Value for judging misfire:
	 Cycles for which the IMEP is lower than this setting are judged as misfires, and the 

rate of misfire is determined by the ratio of the number of misfiring cycles relative to 
the total number of cycles.

24	Measured fuel consumption and Number of cylinders:
	 Measures the fuel consumption, and when using the result for calculations, you 

can select this item or specify how many cylinders worth of fuel consumption it 
represents. In the TDC Correction and Calibration Factor Setting screen, it is 
assumed that fuel consumption (Gfuel) is assigned to a channel.

34	Measured exhaust gas pressure:
	 Select this item when measuring the pressure of exhaust gas and using the result 

for calculations. In the TDC Correction and Calibration Factor Setting screen, it 
is assumed that exhaust gas pressure (Pex) is assigned to a channel.

36	Measured exhaust gas temperature:
	 Select this item when measuring the temperature of exhaust gas and using the 

result for calculations. In the TDC Correction and Calibration Factor Setting 
screen, it is assumed that exhaust gas temperature (Tex) is assigned to a channel.

38	Measured revolutions per minute:
	 Select this item when measuring rpm’s and using the result for calculations. In the 

TDC Correction and Calibration Factor Setting screen, it is assumed that rpm 
(Ne) is assigned to a channel.

40	Measured intake manifold temperature:
	 Select this item when measuring the temperature of the intake manifold and using 

the result for calculations. In the TDC Correction and Calibration Factor Setting 
screen, it is assumed that fuel consumption(Td) is assigned to a channel.

42	Measured intake manifold pressure:
	 Select this item when measuring the pressure in the intake manifold and using the 

result for calculations. In the TDC Correction and Calibration Factor Setting 
screen, it is assumed that intake manifold pressure (Pitk) is assigned to a channel.

Button Operations
Back:	� Saves settings and returns to the TDC Correction and Calibration Factor 

Settings screen.
Next:	� Saves settings, moves to the Monitor screen, and starts updating of the Monitor 

screen.
Exit:	 Saves settings and closes the screen.
Cancel:	 Discards settings and closes the screen.

4.7  Setting Calculation Parameters (Parameter Settings Screen)
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4.8	 Displaying Measured Data

		

Monitor function active
Distinguishes between raw 
data (v) and corrected data (v)

Click Display > Measured data

Functions
•	 Displays a crank angle graph in the Monitor screen of raw data (voltage data) that has 

been filtered according to the filter conditions.
•	 Raw data can be either before or after TDC correction, and you can select which data 

to display.
	 View > Measured data > Raw data:	 Displays raw data before TDC correction
	 View > Measured data > Corrected data:	Displays raw data after TDC correction
•	 Shows the displayed channels, displayed cycles, and the current filter settings.
•	 When filter settings are changed, the display is updated.
•	 When nothing is displayed in the window, click File > Setup Wizard, or click . The 

measured data Monitor screen and Setup screen appear.

Button Operations (Icons)
 (Monitor > Start):	Starts the monitor.
 (Monitor > Stop):	Stops the monitor.
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4.9	 Displaying Crank Angle Graphs

		

Displays the value of the selected item

Name and unit of selected analysis data item

Click View > Crank angle graph > Cylinder pressure*
*	 You can select the analysis data items to display from the ones below. However some may 

not be selectable depending on the measurement condition settings. For details, see section 
4.3, “Displayable Analysis Data Items.”

	 Cylinder pressure, rate of cylinder pressure rise, amount of heat release, rate of heat 
release, combustion mass rate, cylinder gas temperature, cylinder piston displacement, and 
other signals

Functions
•	 Displays a crank angle graph of one cycle’s worth of combustion pressure analysis 

results.
•	 The selected measurement items whose check boxes are selected (enabled) in the 

Numeric Analysis Data Items and Parameter Settings screens are displayed in the 
lower portion of the screen.
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4.10	 Displaying Numeric Analysis Data Items

		

Displays the value of the selected item

Displays the one selected item as a trend

Click View > Analysis data item

Functions
•	 Displays one cycle’s worth of combustion pressure analysis results in a list.
•	 The selected one numeric analysis data item is displayed as a trend. The item to 

trend-display can be selected when the monitor is stopped.
•	 The items selected from the measurement items whose check boxes are selected 

(enabled) in the Parameter Settings screen are displayed in the lower right portion of 
the screen.
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4.11	 Saving Measured Data (Saving to wdf Files)

		

		

While monitoring, click Save Waveform on the File menu or click .

Functions
•	 Interrupts the monitor and displays the screen for Measuring data. When the number 

of cycles (when firing) specified in the measurement conditions is acquired, the file 
save dialog box is displayed. The raw (measured) data that has not undergone TDC 
correction or filtering is saved.

•	 When saving files, you can specify the number of cycles at which to start and stop 
loading.

•	 When saving is completed, the Calculation screen is automatically displayed.
•	 If you cancel the file save dialog box, the Measurement Wizard closes (and the 

Calculation screen is not displayed). To start the monitor again, click Monitor > Start 
monitor, or click .

•	 When data acquisition starts, the Measuring data screen appears displaying the 
status and progress of data acquisition.

•	 When saving is completed, the Calculation screen is automatically displayed.
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Setting/Display Data (the Save As Dialog Box)

		

Use this screen to specify the folder where files will be saved to and the file name.
You can specify the number of cycles to save using the start cycle and end cycle.

No. Item Description
1 No. of strokes Displays the number of strokes in the selected file
2 No. of effective cycles Displays the number of effective cycles in the selected 

file
3 No. of cycles to start/stop loading Specifies the range of cycles with which to perform 

analysis of measured data files
4 Angular resolution Displays the angular resolution of the selected file

Setting/Display Data (Measuring Data Screen)
No. Item Description
1 Progress bar Displays the progress. The display is updated every 

2 seconds during measurement, and the progress is 
reset to 0 when it reaches 100% (progresses 10% in 2 
seconds).

2 Acquiring combustion data/trigger 
wait state

Displays after measurement starts when in trigger 
wait state. If this state continues, no external sampling 
signal is being input, or triggers are not activating. 
Click Abort.

3 Acquiring combustion data/
performing trigger measurement

Displayed when a trigger activates and data is 
acquired

Button Operations
Abort:	 Aborts measurement and returns to the Monitor screen.
Save:	 Saves the file to the specified data file and moves to the Calculation screen.
Cancel:	 Cancels saving of combustion data and reopens the monitor.

Note
Can only save when monitoring (when the monitor start icon is active).

4.11  Saving Measured Data (Saving to wdf Files)
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5.1 Loading Measured Data

Click File > Load measured data, or click 

Functions
•	 Loads the selected measured data file.
•	 To load data, set the following values.

•	 Number of strokes
•	 Range of cycles to be analyzed (load start cycle / load end cycle)
•	 Crank angle resolution

•	 When loading is complete, the Measured Data Display screen (section 5.3) and 
Calculation screen (section 5.5) open automatically.

Chapter 5	 Combustion Pressure Analysis Function
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Setting/Display Data
No. Item Default Setting Data 

Type
Size Numerical Data 

Min. Value Max. Value
1 No. of Strokes Value when saving - - - -
2 No. of effective cycles Value when saving I 5.0 1 25000
3 Start cycle 1 I 5.0 1 25000
4 End cycle Number of effective 

cycles
I 5.0 1 25000

5 Angular Resolution 1.0 CA - - -
6 Measuring Instrument - - - - -

2	 No. of effective cycles: When selecting the file to be loaded, the angular resolution 
is assumed to be 1 CA, and the number of effective cycles is calculated using the 
equation below. If the angular resolution is changed to 0.5, 0.25, or 0.1, the number 
of effective cycles is updated accordingly.

	 (portion before the decimal (no. of measured data / no. of data per cycle)) - 3
	 The maximum number of effective cycles varies depending on the angular 

resolution as follows.
•	 For 1 CA:		  25000 cycles
•	 For 0.5 CA:	 12500 cycles
•	 For 0.25 CA:	 6250 cycles
•	 For 0.1 CA:	 2500 cycles

3	 Start cycle, End cycle: Enter the range of cycles to be analyzed (up to 800 cycles). 
You cannot enter a value greater than the number of effective cycles for the data 
under analysis.

5	 Angular Resolution: Select 1, 0.5, 0.25, or 0.1 according to the conditions during 
measurement.

6	 Measuring Instrument: When loading files, the appropriate instrument is 
automatically selected.

Button Operations
Open:	� Checks the start and stop cycles, and if the setting is correct, opens the 

Measured Data Display screen (see section 5.3) and the Calculation screen (see 
section 5.5). If the number of start/end cycles selected exceeds the maximum 
number of cycles of the data to be analyzed, a message is displayed.

Cancel:	 Clears all screen settings and closes the screen.

5.1  Loading Measured Data
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5.2 Saving/Loading Analysis Condition

Analysis Condition Loading screen

		

Analysis Condition Saving screen

		

Click File > Open/save analysis conditions,or click , or 

Functions
Loading Analysis Condition
•	 Loads analysis conditions (TDC correction value, Number of cylinders, interval of 

absolute pressure correction, coefficients for conversion to physical values (calibration 
factors), filter setting conditions, calculation parameters, calculation execution items, 
analysis graph display conditions, screen layout), and places them into effect as the 
current conditions.

	 Note that when executing this function, all previously calculated analysis results are 
discarded, and any currently displayed analysis results windows (crank angle graphs, 
cycle graphs, or numeric analysis data items) are forcibly closed. After recalculation, 
display the analysis results window.

Saving Analysis Condition
•	 Saves analysis conditions (TDC correction value, Number of cylinders, interval of 

absolute pressure correction, coefficients for conversion to physical values (calibration 
factors), filter setting conditions, calculation parameters, calculation execution items, 
analysis graph display conditions, screen layout).
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5.3 Displaying Measured Data

		

Displays the file name, range of cycles displayed, 
and angular resolution

Analysis function active

Distinguishes between raw data (v) and corrected data (v)

Click Display > Measured data > Raw data or Corrected data

Functions
•	 Displays a crank angle graph in the analysis screen of loaded measured data that has 

been filtered (raw data).
•	 Raw data can be either before or after TDC correction, and you can select which data 

to display.
	 View > Measured data > Raw data:	 Displays raw data before TDC correction
	 View > Measured data > Corrected data:	 Displays raw data after TDC correction
•	 The data name, cycle range, and angular resolution are displayed in the title bar of the 

window.
•	 Shows the displayed channels, displayed cycles, and the current filter settings.
•	 When filter settings are changed, the display is updated.
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5.4	 Setting the TDC Correction Value and 
Calibration Factor

Calculates the correction value using loaded measured data

Click Settings > TDC correction and calibration factor, or click 

Functions
•	 You can change the calculated TDC correction value, number of engine cylinders, and 

cylinder-to-cylinder TDC correction value.
•	 When you click Calculate, the TDC correction value for the measured data being 

displayed is recalculated.
•	 When changing these settings, all previously calculated analysis results are discarded, 

and any currently displayed analysis results windows (crank angle graphs, cycle 
graphs, or numeric analysis data items) are forcibly closed. After recalculation, display 
the analysis results window.

•	 For details on setting the TDC correction value and calibration coefficient, see section 
4.6.
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5.5 Combustion Pressure Analysis

		

Click Calculation > Calculate, or click 

Functions
•	 You can select analysis data items and perform calculation. Cylinder pressure and 

rate of cylinder pressure rise are always analyzed.
•	 The check boxes of calculated items are selected. If a particular calculation is 

impossible, the item is skipped and the software advances to the next item.

Button Operations
Calculate:	� Calculates the selected data items (including related calculations). 

Click Calculate to display the Calculating screen. To stop the 
calculation in progress, click Stop.

Close Button:	 This button appears when calculation ends. Closes the window.
Cancel Button:	 This button disappears when calculation is started. Closes the window.
Select All Button:	 Selects all items for analysis.

		

Displays the progress of calculation
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5.6 Displaying Crank Angle Graphs

Displaying 2D Graphs

		

Displays the value of the selected item

Displays the name of the analysis data 
item to be displayed.

Click View > Crank angle graph > Cylinder pressure*
*	 You can select the analysis data item to display from the ones below. However you 

cannot select an item that has not been calculated. For information on performing 
calculations, see section 5.5.

	 Cylinder pressure, rate of cylinder pressure rise, amount of heat release, rate of 
heat release, combustion mass rate, cylinder gas temperature, cylinder piston 
displacement, logarithmic cylinder pressure, polytropic index, ratio of specific heat, 
and other signals

Functions
•	 Displays a crank angle graph of the combustion pressure analysis results.
•	 The selected values from the cycle graph data items and the measurement items set 

to Use in Calculations in the Parameter Settings screen are displayed in the lower 
right portion of the screen.

	 The following shows how the displayed contents varies depending on the settings for 
displayed channels and displayed cycles (see section 3.3, “Common Operations”).

Display Channels Cycles Displayed Value
Specified channel Specified cycle Value for specified cycles

AVE Same values as in the numeric analysis data item screen
ALL None

ALL - None
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Displaying 3D Graphs
If you select “3D” on the Graph Dimension Settings screen (see section 3.3, “Graph 
Operations”), the following 3D display appears.

		

Click View > Crank angle graph

Functions
•	 Crank angle display data is extracted each number of specified cycles from the 

specified range of cycles, and a 3D graph is displayed.
•	 The maximum number of cycles that can be displayed is 20.

Setting/Display Data
No. Item Default Setting Data 

Type
Size Numerical Data

Min. Value Max. Value
1 Range of Cycles Extracted cycles I 3 1 800

5.6  Displaying Crank Angle Graphs



5-9IM 720340-02EN

C
om

bustion Pressure A
nalysis Function

1

2

3

4

5

6

7

8

App

Index

5.7 Displaying Cycle Graphs

		

Displays the value of the selected item

Displays the name of the analysis data item to be displayed.

Click View > Cycle graph > Max. cylinder pressure*
*	 You can select the analysis data item to display from the ones below. However you cannot 

select an item that has not been calculated. For information on performing calculations, see 
section 5.5.

	 Maximum cylinder pressure, angle of maximum cylinder pressure, averaged maximum 
cylinder pressure of all cylinders, averaged angle at maximum cylinder pressure of all 
cylinders, maximum rate of cylinder pressure rise, maximum angle of cylinder pressure rise, 
averaged maximum rate of cylinder pressure rise of all cylinders, average angle of maximum 
rate of cylinder pressure rise of all cylinders, NMEP, averaged NMEP of all cylinders, IMEP, 
averaged IMEP of all cylinders, PMEP, averaged PMEP of all cylinders, angle of maximum 
heat release, maximum amount of heat release, angle of maximum rate of heat release, 
maximum rate of heat release, angle at combustion mass rate N1%, angle at combustion 
mass rate N2%, angle at combustion mass rate N3%, other signals

Functions
•	 Displays a cycle graph of the combustion pressure analysis results in the Analysis 

screen.
•	 Displays in the bottom of the screen the average values (the same values as those in 

the Numeric Analysis Data Item screen) of the items selected from among the cycle 
graph items and the measurement items whose check boxes are selected (enabled) 
in the Parameter Settings screen .
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5.8 Displaying Numeric Analysis Data Items

		

Click View > Analysis data item

Functions
•	 Displays the numeric analysis data items of the combustion pressure analysis results.
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5.9 Saving Analysis Data

		

Click File > Save analysis data, or click 

Functions
•	 Test information can be entered and combustion pressure analysis results can be 

saved to a file in CSV format.

Setting/Display Data
For Numeric Data

No. Item Default Setting Data Type Size Min. Value Max. Value
1 Data Name Prev. value C(N) 8 - -
2 Testing Personnel Prev. value C 8 - -
3 Department Prev. value C(N) 16 - -
4 Test Name Prev. value C(N) 32 - -
5 Engine model Prev. value C(N) 16 - -
6 Serial No. Prev. value C(N) 16 - -
7 Place of Test Prev. value C(N) 16 - -
8 Test Bench Prev. value C(N) 16 - -
9 Comments Prev. value C(N) 32 - -
10 Start cycle, End cycle Prev. value I 5.0 1 25000

10	Start cycle, End cycle: To save a specified range of cycles of crank angle graph 
data from the analysis results to a CSV file, choose this command, then enter the 
range of cycles to be saved. The suffix “-all” is added to the specified file name. For 
example, if you name the file Sample, the actual file name will change to Sample-
all.csv when saved.

Button Operations
Cancel:	 Clears all screen settings and closes the window.
Save:	� Displays a window allowing you to specify the save location. Clicking OK in that 

window saves combustion pressure analysis results data to a text file in CSV 
format. Raw data cannot be saved.
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5.10	 Setting Filter Conditions and Calculation 
Parameters

Functions
You can change the following settings and perform combustion pressure analysis.
For details on settings, see the corresponding sections listed.
•	 Filter conditions:		 Section 4.4
•	 Calculation parameters:	 Section 4.7



6-1IM 720340-02EN

C
SV Files

1

2

3

4

5

6

7

8

App

Index

6.1 Format of Analysis Data

Test Information, Manually Input Data Items
Test Information
Test date
Data name
Testing personnel
Department
Test name
Engine type
Serial No.
Place of test
Test bench type
Comments

Manually Input Data Items
Calculated TDC correction value (CA)
Number of cylinders
Channel-by-channel TDC correction value (CA)
Channel-by-channel calibration factor A (kPa/V)
Channel-by-channel calibration factor B (kPa/V)
Channel-by-channel used/unused (1: Used)
Starting angle of correction interval (CA)
Ending angle of correction interval (CA)
Channel name
Con-rod length (m)
Bore (m)
Piston offset (m)
Stroke length (m)
Piston head ratio
Clearance volume (m3)
Compression ratio
Presence/absence of supercharging
Boost pressure (kPa)
Supercharger inlet pressure (kPa)
Supercharger inlet temperature (°C)
Boost temperature (°C)
Presence/absence of heat loss processing
Angle for start point of combustion (point a) (CA)
Number of data items for judging start point of combustion
Angle for end point of combustion (point b) (CA)
Number of data items for judging end point of combustion
Start point of searching maximum rate of heat release (CA)
End point of searching maximum rate of heat release (CA)
Ratio for judging angle of combustion mass rate N1 (%)
Ratio for judging angle of combustion mass rate N2 (%)
Ratio for judging angle of combustion mass rate N3 (%)
Value for judging misfire (kPa)
Fuel consumption (m3/s)
Number of cylinders (used to calculate fuel consumption)
Heat release at lowest position (J/kg)

Chapter 6	 CSV Files
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Gas constant (×9.80665 J/kg.K)
Suction volumetric efficiency (%)
Specific gravity
Cylinder head wall temperature (°C)
Cylinder wall temperature (°C)
Piston head wall temperature (°C)
Exhaust gas pressure (kPa)
Exhaust gas temperature (°C)
Revolutions per minute (rpm)
Atmospheric temperature (°C)
Atmospheric pressure (kPa)
Method of absolute pressure correction

Calculation Results
Calculation Data Items: Numeric Analysis Data
Average cylinder pressure across correction interval (kPa)
Averaged maximum cylinder pressure (kPa)
Standard deviation of maximum cylinder pressure (kPa)
Rate of change in maximum cylinder pressure (%)
Averaged maximum rate of cylinder pressure rise (kPa/deg)
Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)
Rate of change in maximum rate of cylinder pressure rise (%)
Piston displacement (m3)
Averaged NMEP (kPa)
Standard deviation of NMEP (kPa)
Rate of change in NMEP (%)
Averaged IMEP (kPa)
Standard deviation of IMEP (kPa)
Rate of change in IMEP (%)
Averaged PMEP (kPa)
Standard deviation of PMEP (kPa)
Rate of change in PMEP (%)
Averaged maximum cylinder gas temperature (°C)
Standard deviation of maximum cylinder gas temperature (°C)
Rate of change in maximum cylinder gas temperature (%)
Averaged maximum rate of heat release (J/deg)
Standard deviation of maximum rate of heat release (J/deg)
Rate of change in maximum rate of heat release (%)
Averaged maximum amount of heat release (J)
Standard deviation of maximum amount of heat release (J)
Rate of change in maximum amount of heat release (%)
Averaged angle at combustion mass rate N1 % (CA)
Standard deviation of angle at combustion mass rate N1 % (CA)
Rate of change in angle at combustion mass rate N1 % (%)
Averaged angle at combustion mass rate N2 % (CA)
Standard deviation of angle at combustion mass rate N2 % (CA)
Rate of change in angle at combustion mass rate N2 % (%)
Averaged angle at combustion mass rate N3 % (CA)
Standard deviation of angle at combustion mass rate N3 % (CA)
Rate of change in angle at combustion mass rate N3 % (%)
Average start point of combustion (point a) (CA)
Average end point of combustion (point b) (CA)

6.1  Format of Analysis Data
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Minimum value of IMEP (kPa)
LNV of IMEP (%)
Rate of misfire (%)
Averaged maximum cylinder pressure of all cycles and cylinders (kPa)
Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa/deg)
Averaged NMEP of all cycles and cylinders (kPa)
Averaged IMEP of all cycles and cylinders (kPa)
Averaged PMEP of all cycles and cylinders (kPa)
Minimum IMEP of all cycles and cylinders (kPa)
LNV of IMEP of all cycles and cylinders (%)
Mass of intake fuel (kg)
Mass of intake air (kg)
Excess air factor
Corrected gas constant
Mass of remaining gas (kg)

Calculation Data Items: Crank Angle Graph Data Items
Crank angle
Average cylinder pressure (kPa)
Logarithmic average cylinder pressure (kPa)
Piston displacement (m)
Piston displacement (m3)
Average rate of cylinder pressure rise (kPa/deg)
Average cylinder gas temperature (°C)
Average rate of heat release (J/deg)
Average amount of heat release (J)
Average combustion mass rate (%)
Ratio of specific heat
Polytropic index
Rate of heat release (Received heat) (J/deg)
Rate of heat release (Heat loss) (J/deg)

Calculation Data Items: Cycle Graph Data Items
Cycle
Maximum cylinder pressure (kPa)
Crank angle at maximum cylinder pressure (CA)
Averaged maximum cylinder pressure of all cylinders (kPa)
Averaged crank angle at maximum cylinder pressure of all cylinders (CA)
Maximum rate of cylinder pressure rise (kPa/deg)
Crank angle at maximum rate of cylinder pressure rise (CA)
Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/deg)
Averaged angle at maximum rate of cylinder pressure rise of all cylinders (CA)
Compression/expansion work (J)
Pumping loss (J)
NMEP (kPa)
Averaged NMEP of all cylinders (kPa)
IMEP (kPa)
Averaged IMEP of all cylinders (kPa)
PMEP (kPa)
Averaged PMEP of all cylinders (kPa)
Maximum cylinder gas temperature (°C)
Crank angle at maximum cylinder gas temperature (CA)

6.1  Format of Analysis Data
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Maximum rate of heat release (J/deg)
Crank angle at maximum rate of heat release (CA)
Maximum amount of heat release (J)
Crank angle at maximum amount of heat release (CA)
Angle at combustion mass rate N1 % (CA)
Angle at combustion mass rate N2 % (CA)
Angle at combustion mass rate N3 % (CA)
Start point of combustion (point a) (CA)
End point of combustion (point b) (CA)

*	 When carrying out a per-cycle absolute pressure correction, the per-cycle absolute pressure 
correction value are left in the Calculation Item: Cycle Graph Data field.

Calculation Data Items: Crank Angle Graph Data (Other Signals) MBT2
Crank angle
Intake manifold pressure (kPa)
Fuel consumption (cm3/s)
Revolutions per minute (rpm)
Intake manifold temperature (°C)
Exhaust gas pressure (kPa)
Exhaust gas temperature (°C)
Supercharger inlet pressure (kPa)
Supercharger inlet temperature (°C)
Other signals (Crank angle graph data)

Calculation Data Items: Cycle Graph Data Items (Other Signals)
Cycle
Intake manifold pressure (kPa)
Fuel consumption (cm3/s)
Revolutions per minute (rpm)
Intake manifold temperature (°C)
Exhaust gas pressure (kPa)
Exhaust gas temperature (°C)
Supercharger inlet pressure (kPa)
Supercharger inlet temperature (°C)
Other signals (Cycle graph data)

6.1  Format of Analysis Data
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Crank Angle Graph Data of Specified Range of Cycles
Crank angle
Cylinder pressure (kPa)
Logarithmic cylinder pressure (kPa)
Rate of cylinder pressure rise (kPa/deg)
Cylinder gas temperature (°C)
Rate of heat release (J/deg)
Amount of heat release (J)
Combustion mass rate (%)
Ratio of specific heat
Rate of heat release (Received heat) (J/deg)
Rate of heat release (Heat loss) (J/deg)
Intake manifold pressure (kPa)
Fuel consumption (cm3/s)
Revolutions per minute (rpm)
Intake manifold temperature (°C)
Exhaust gas pressure (kPa)
Exhaust gas temperature (°C)
Supercharger inlet pressure (kPa)
Supercharger inlet temperature (°C)
Other signals (Crank angle graph data)

*	 Intake manifold pressure, fuel consumption, rpm, intake manifold temperature, exhaust gas 
pressure, exhaust gas temperature, supercharger inlet pressure, and supercharger inlet 
temperature are saved only when they are measured.

6.1  Format of Analysis Data
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7.1 Explanation of Equations

In the explanations below, 720 indicates the angle at cycle 1 for a 4-cycle engine. 
Substitute 360 for a 2-cycle engine.

1.	 Pθ in
Cylinder pressure (kPa) of the specified range of cycles extracted after rotational offset 
correction and TDC correction

Pθ in = A × U[720,N] + B

N:		 Number of cycles
U:		� Voltage value (measured value) of the specified range of cycles extracted after 

rotational offset correction and TDC correction (V)
A, B:	Sensor calibration factor (kPa/V) (manually input)

2.	 Padj[N] 
Average cylinder pressure (kPa) of the specified crank angle range used for the absolute 
pressure correction

For per-cycle average
Padj[N] = ave(Pθ in[θ = adj θ1 to adj θ2,N])		 # ave: average value
For all-cycle average
Padj[N] = ave(Pθ in_ave[θ = adj θ1 to adj θ2])	 # ave: average value

N:				   Number of cycles
Pθ in:	 	 �Cylinder pressure (kPa) (calculated value) of the specified range of cycles 

extracted after rotational offset correction and TDC correction
Pθ in_ave:	Average cylinder pressure (kPa) (calculated value)
	 	 	 	 Pθ in_ave[720] = (1 / N) × ∑(Pθ in[720,N])
adj θ1:	 	 �Starting angle (CA) of the range used for absolute pressure correction 

(manually input)
adj θ2:	 	 �Ending angle (CA) of the range used for absolute pressure correction 

(manually input)

3.	 Pitk_ave[N]
Average intake manifold pressure at each cycle (kPa)

When intake manifold pressure is set to be measured and used in calculations:
Pitk_ave[N] = ave(Pθ itk[720,N])	 	 # ave: average value

N:			  Number of cycles
Pθ itk:	 Intake manifold pressure (kPa) (measured value)

Chapter 7	 Equations



7-2 IM 720340-02EN

4.	 Pθ [720,N] 
Cylinder pressure after absolute pressure correction (kPa)

•	 When the atmospheric and boost pressures are manually input,
	 Pθ [720,N] = Pθ in[720,N] – Padj[N] + Pa + Pt
•	 When depending on the measured intake manifold pressure,
	 Pθ [720,N] = Pθ in[720,N] – Padj[N] + Pitk_ave[N]

N:				   Number of cycles
Pθ in:	 	 �Cylinder pressure (kPa) after rotational offset correction and TDC 

correction (calculated value)
Padj:			�  Average cylinder pressure across correction interval (kPa) (calculated 

value)
Pa:			   Atmospheric pressure (kPa) (manually input)
Pt:				   Boost pressure (kPa) (manually input)
Pitk_ave:	 Average intake manifold pressure (kPa) (calculated value)

5.	 logPθ [720,N] 
Logarithmic cylinder pressure (kPa)

logPθ [720,N] = log10(Pθ [720,N])

N:		 Number of cycles
Pθ:	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)

6.	 Pθ ave[720]
Average cylinder pressure (kPa)

Pθ ave[720] = (1 / N) × ∑(Pθ [720,N])

N:		 Number of cycles
Pθ:	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)

7.	 logPθ ave[720] 
Logarithmic average cylinder pressure (kPa)

logPθ ave[720] = log10(Pθ ave[720])

Pθ ave:	Average cylinder pressure (kPa) (calculated value)

7.1  Explanation of Equations
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8.	 Xθ [720]
Piston displacement (m)

R = S/2
φ = arcsin(γ/(L+R))
Xθ [720] = sqrt ((R+L)2 – γ2) – R × cos((θ + α) × pi / 180) + φ)  
	 – sqrt(L2 – (–R × sin((θ +α) × (pi / 180) + φ) + γ)2)	 # sqrt: square root

S:	Stroke length (m) (manually input)
L:	 Con-rod length (m) (manually input)
γ:	 Piston offset (m) (manually input)
θ:	Crank angle (CA) radian
	 	 4-cycle engine: –360 to +359 CA: at 1 CA resolution
	 	 2-cycle engine: –180 to +179 CA: at 1 CA resolution
α:	The numbers to the right of the decimal of the TDC correction value (CA) (calculated 

or manually input).  In other words, given an angular resolution of 1 CA, the value 
is (θ - α) = 0-α, 1-α, . . .

pi:	The circular constant

				  

γ

L 

S/2 

BDC 

TDC

S
φ

9.	 Vθ [720] 
Piston displacement (m3)

When Clearance volume is selected on the Parameter Settings screen
Vθ [720] = (pi/4) × B2 × Xθ [720] + Vc
When Compression ratio is selected on the Parameter Settings screen
Vθ [720] = (pi/4) × B2 × Xθ [720] + Vst / (Cr–1)

pi:		 The circular constant
B:		 Bore (m) (manually input)
Xθ:	 Piston displacement (m) (calculated value)
Vc:	 Clearance volume (m3) (manually input)
Vst:	 Piston displacement (m3) (calculated value)
Cr:	 Compression ratio (manually input)

7.1  Explanation of Equations
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10.	 dVθ [720]
Rate of piston displacement increase (m3/deg)

dVθ [720] = (Vθn-2 – 8 × Vθn-1 + 8 × Vθn+1 – Vθn+2) / (12 × res)
	 When the angular resolution is 1 CA, the calculation is made as shown below.
	 When n = 1 or 2, (Vθn-2, Vθn-1) = (Vθ719, Pθ720) or (Vθ720, Vθ001)
	 When n = 719 or 720, (Vθn+1, Vθn+2) = (Vθ720, Vθ001) or (Vθ001, Vθ002)

Vθ:	 Piston displacement (m3) (calculated value)
res:	 Angular resolution (1, 0.5, 0.25, or 0.1 CA)

11.	 logVθ [720] 
Logarithmic piston displacement (m3)

logVθ [720] = log10(Vθ [720])

Vθ:	 Piston displacement (m3) (calculated value)

12.	 dPθ [720,N]
Rate of cylinder pressure rise (kPa/deg)

dPθ [720, N] = (Pθn-2 – 8 × Pθn-1 + 8 × Pθn+1 – Pθn+2) / (12 × res)
	 When the resolution is 1 CA, the calculation is made as shown below.
	 When n = 1 or 2, (Pθn–2, Pθn–1) = (Pθ001, Pθ001) 
	 When n = 719 or 720, (Pθn+1, Pθn+2) = (Pθ720, Pv720)

N:		 Number of cycles
Pθ:	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)
res:	 Angular resolution (1, 0.5, 0.25, or 0.1 CA)

13.	 dPθ ave[720]
Average rate of cylinder pressure rise (kPa/deg)

dPθ ave[720] = (1 / N) × ∑(dPθ [720,N])

N:		 Number of cycles
dPθ:	 Rate of cylinder pressure rise (kPa/deg) (calculated value)

14.	 Pmax[N]
Maximum cylinder pressure (kPa)

Pmax[N] = max(Pθ [720,N])	 # max: maximum value

N:		 Number of cycles
Pθ:	 Cylinder pressure (kPa) (calculated value)

15.	 θPmax [N]
Crank angle at maximum cylinder pressure (CA)

θPmax[N] = pos(Pθ [720,N])	 # pos: crank angle at max. cylinder pressure

N:		 Number of cycles
Pθ:	 Cylinder pressure (kPa) (calculated value)

7.1  Explanation of Equations
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16.	 θPmax_ave
Averaged crank angle at maximum cylinder pressure (CA)

θPmax_ave = (1 / N) × ∑(θPmax [N])

N:			  Number of cycles
θPmax:	Crank angle at maximum cylinder pressure (CA) (calculated value)

17.	 Pmax_ave
Averaged maximum cylinder pressure (kPa)

Pmax_ave = (1 / N) × ∑(Pmax [N])

N:			  Number of cycles
Pmax:	 Maximum cylinder pressure (kPa) (calculated value)

18.	 Pmax_std
Standard deviation of maximum cylinder pressure (kPa)

Pmax_std = sqrt((1 / (N–1)) × ∑(Pmax [N] – Pmax_ave)2) 	 # sqrt: square root

N:				   Number of cycles
Pmax:		  Maximum cylinder pressure (kPa) (calculated value)
Pmax_ave:	Averaged maximum cylinder pressure (kPa) (calculated value)

19.	 Pmax_cov
Rate of change (%) in maximum cylinder pressure

Pmax_cov = (Pmax_std / Pmax_ave) × 100

Pmax_std:	Standard deviation of the max. cylinder pressure (kPa) (calculated value)
Pmax_ave:	Averaged max. cylinder pressure (kPa) (calculated value)

20.	 Pmax_Cy[N]
Averaged maximum cylinder pressure of all cylinders (kPa)

Pmax_cy[N] = (1 / Cy) × ∑(Pmax [Cy,N])

Cy:		  Number of cylinders
N:			  Number of cycles
Pmax:	 Maximum cylinder pressure (kPa) (calculated value)

21.	 Pmax_Cy_ave
Averaged maximum cylinder pressure of all cycles and cylinders (kPa)

Pmax_Cy_ave = (1 / N) × ∑(Pmax_Cy [N])

N:				   Number of cycles
Pmax_Cy:	 �Averaged maximum cylinder pressure of all cylinders (kPa) (calculated 

value)

7.1  Explanation of Equations
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22.	 θPmax_Cy [N]
Averaged crank angle at maximum cylinder pressure of all cylinders (CA)

θPmax_Cy[N] = (1 / Cy) × ∑(θPmax [Cy,N])

Cy:		  Number of cylinders
N:			  Number of cycles
θPmax:	Crank angle at maximum cylinder pressure (CA) (calculated value)

23.	 θPmax_Cy_ave
Averaged crank angle at maximum cylinder pressure of all cycles and cylinders (CA)

θPmax_Cy_ave = (1 / N) × ∑(θPmax_Cy[N])

N:					    Number of cycles
θPmax_Cy:	 �Averaged crank angle at maximum cylinder pressure of all cylinders (CA) 

(calculated value)

24.	 dPmax[N]
Maximum rate of cylinder pressure rise (kPa/deg)

dPmax[N] = max(dPθ [720,N])	 # max: maximum value

N:		 Number of cycles
dPθ:	 Rate of cylinder pressure rise (kPa/deg) (calculated value)

25.	 θdPmax[N]
Crank angle at maximum rate of cylinder pressure rise (CA)

θdPmax[N] = pos(dPθ [720,N])
	 # pos: crank angle at the maximum rate of cylinder pressure rise

N:		 Number of cycles
dPθ:	 Rate of cylinder pressure rise (kPa/deg) (calculated value)

26.	 θdPmax_ave
Averaged crank angle at maximum rate of cylinder pressure rise (CA)

θdPmax_ave = (1 / N) × ∑(θdPmax [N])

N:				   Number of cycles
dPθmax:	 �Crank angle at maximum rate of cylinder pressure rise (CA) (calculated 

value)

27.	 dPmax_ave
Averaged maximum rate of cylinder pressure rise (kPa/deg)

dPmax_ave = (1 / N) × ∑(dPmax [N])

N:			  Number of cycles
dPmax:	Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)

7.1  Explanation of Equations
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28.	 dPmax_std
Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)

dPmax_std = sqrt((1 / (N–1)) × ∑(dPmax [N] – dPmax_ave)2)	# sqrt: square root

N:					    Number of cycles
dPmax:			   Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)
dPmax_ave:	 �Averaged maximum rate of cylinder pressure rise (kPa/deg) (calculated 

value)

29.	 dPmax_cov
Rate of change (%) in maximum cylinder pressure rise

dPmax_cov = (dPmax_std / dPmax_ave) × 100

dPmax_std:	 �Standard deviation of maximum rate of cylinder pressure rise (kPa/deg) 
(calculated value)

dPmax_ave:	 �Averaged maximum rate of cylinder pressure rise (kPa/deg) (calculated 
value)

30.	 dPmax_Cy[N]
Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/deg)

dPmax_Cy[N] = (1 / Cy) × ∑(dPmax [Cy, N])

Cy:		  Number of cylinders
N:			  Number of cycles
dPmax:	Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)

31.	 dPmax_Cy_ave
Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa/deg)

dPmax_Cy_ave = (1 / N) × ∑(dPmax_Cy [N])

N:					    Number of cycles
dPmax_Cy:	 �Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/

deg) (calculated value)

32.	 θdPmax_Cy [N]
Averaged crank angle at maximum rate of cylinder pressure rise of all cylinders (CA)

θdPmax_Cy[N] = (1 / Cy) × ∑(θdPmax [Cy, N])

Cy:			   Number of cylinders
N:				   Number of cycles
θdPmax:	 �Crank angle at maximum rate of cylinder pressure rise (CA) (calculated 

value)

33.	 θdPmax_Cy_ave
Averaged crank angle at maximum rate of cylinder pressure rise of all cycles and 
cylinders (CA)

θdPmax_Cy_ave = (1/N) × ∑(θdPmax_Cy [N])

N:					    Number of cycles
θdPmax_Cy:	 �Averaged crank angle at maximum rate of cylinder pressure rise of all 

cylinders (CA) (calculated value)

7.1  Explanation of Equations
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34.	 Wpower[N]
Compression/expansion work (J)

∆V = abs(Vθi – Vθi+1)	 # abs: absolute value
A[N] = ∑ (0.5 × (Pθi + Pθi+1) × 1000.0 × ∆V)		 	 θ = –180 to –1
B[N] = ∑ (0.5 × (Pθi + Pθi+1) × 1000.0 × ∆V) 	 	 θ = 0 to 179
Wpower[N] = B[N] – A[N]
For a 2-cycle engine, when θ = 179, Pθi+1 is Pθi, and Vθi+1 is Vθ–180.

N:		 Number of cycles
Vθ:	 Piston displacement (m3) (calculated value)
Pθ:	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)

35.	 Wpump[N]
Pumping loss (J)

∆V = abs(Vθi – Vθi+1)	 # abs: absolute value
C[N] = ∑ (0.5 × (Pθi + Pθi+1) × 1000.0 × ∆V) 	 	 θ = 180 to 359
D[N] = ∑ (0.5 × (Pθi + Pθi+1) × 1000.0 × ∆V) 	 	 θ = –360 to –181
Wpump[N] = C[N] – D[N]
When θ = 359, Pθi+1 is Pθi, and Vθi+1 is Vθ–360.
Wpump[N] is zero for 2-cycle engines.

N:		 Number of cycles
Vθ:	 Piston displacement (m3) (calculated value)
Pθ:	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)

36.	 Vst
Piston displacement (m3)

Vst = (pi / 4) × B2 × S

pi:	The circular constant
B:	Bore (m) (manually input)
S:	Stroke length (m) (manually input)

37.	 NMEP[N]
NMEP (kPa)

NMEP[N] = (Wpower[N] / 1000.0 – Wpump[N] / 1000.0) / Vst

N:				   Number of cycles
Wpower:	 Compression/expansion work (J) (calculated value)
Wpump:		 Pumping loss (J) (calculated value)
Vst		  :	 Piston displacement (m3) (calculated value)

38.	 NMEP_ave
Averaged NMEP (kPa)

NMEP_ave = (1 / N) × ∑(NMEP[N])

N:			  Number of cycles
NMEP:	 NMEP (kPa) (calculated value)

7.1  Explanation of Equations
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39.	 NMEP_std
Standard deviation of NMEP (kPa)

NMEP_std = sqrt((1 / (N–1)) × ∑(NMEP[N] – NMEP_ave)2)	 # sqrt: square root

N:					    Number of cycles
NMEP:			   NMEP (kPa) (calculated value)
NMEP_ave:	 Averaged NMEP (kPa) (calculated value)

40.	 NMEP_cov
Rate of change in NMEP (%)

NMEP_cov = (NMEP_std / NMEP_ave) × 100

NMEP_std:	 Standard deviation of NMEP (kPa) (calculated value)
NMEP_ave:	 Averaged NMEP (kPa) (calculated value)

41.	 NMEP_Cy[N]
Averaged NMEP of all cylinders (kPa)

NMEP_Cy[N] = (1 / Cy) × ∑(NMEP[Cy,N])

Cy:		  Number of cylinders
N:			  Number of cycles
NMEP:	 NMEP (kPa) (calculated value)

42.	 NMEP_Cy_ave
Averaged NMEP of all cycles and cylinders (kPa)

NMEP_Cy_ave = (1 / N) × ∑(NMEP_Cy[N])

N:				   Number of cycles
NMEP_Cy:	Averaged NMEP of all cylinders (kPa) (calculated value)

43.	 IMEP[N]
IMEP (kPa)

IMEP[N] = (Wpower [N] / 1000.0) / Vst

N:				   Number of cycles
Wpower:	 Compression/expansion work (J) (calculated value)
Vst:			   Piston displacement (m3) (calculated value)

44.	 IMEP_ave
Averaged IMEP (kPa)

IMEP_ave = (1 / N) × ∑(IMEP[N])

N:			  Number of cycles
IMEP:	 IMEP (kPa) (calculated value)

7.1  Explanation of Equations
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45.	 IMEP_std
Standard deviation of IMEP (kPa)

IMEP_std = sqrt((1 / (N–1)) × ∑(IMEP[N] – IMEP_ave)2) 	 # sqrt: square root

N:	Number of cycles
IMEP:	 IMEP (kPa) (calculated value)
IMEP_ave:	Averaged IMEP (kPa) (calculated value)

46.	 IMEP_cov
Rate of change in IMEP (%)

IMEP_cov = (IMEP_std / IMEP_ave) × 100

IMEP_std:	Standard deviation of IMEP (kPa) (calculated value)
IMEP_ave:	Averaged IMEP (kPa) (calculated value)

47.	 IMEP_min
Minimum value of IMEP (kPa)

IMEP_min = min (IMEP[N])	 # min: minimum value

N:			  Number of cycles
IMEP:	 IMEP (kPa) (calculated value)

48.	 IMEP_LNV
LNV of IMEP (%)

IMEP_LNV = (IMEP_min / IMEP_ave) × 100

IMEP_min:	Minimum value of IMEP (kPa)
IMEP_ave:	Averaged IMEP (kPa) (calculated value)

49.	 R_misfire
Rate of misfire (%)

R_misfire = (count(IMEP[N] < L) / N) × 100
# count: calculates the number of data that are applicable to the specified conditions

N:			  Number of cycles
L:			   Value for judging misfire (kPa) (manually input)
IMEP:	 IMEP (kPa) (calculated value)

50.	 IMEP_Cy[N]
Averaged IMEP of all cylinders (kPa)

IMEP_Cy[N] = (1 / Cy) × ∑(IMEP [Cy, N])

Cy:		  Number of cylinders
N:			  Number of cycles
NMEP:	 IMEP (kPa) (calculated value)

51.	 IMEP_Cy_ave
Averaged IMEP of all cycles and cylinders (kPa)

IMEP_Cy_ave = (1 / N) × ∑(IMEP_Cy [N])

N:				   Number of cycles
IMEP_Cy:	 Averaged IMEP of all cylinders (kPa) (calculated value)

7.1  Explanation of Equations
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52.	 PMEP[N]
PMEP (kPa)

PMEP[N] = ((–1 × Wpump[N]) / 1000.0) / Vst

N:			  Number of cycles
Wpump:	Pumping loss (J) (calculated value)
Vst	 :	 Piston displacement (m3) (calculated value)

53.	 PMEP_ave
Averaged PMEP (kPa)

PMEP_ave = (1 / N) × ∑(PMEP[N])

N:			  Number of cycles
PMEP:	 PMEP (kPa) (calculated value)

54.	 PMEP_std
Standard deviation of PMEP (kPa)

PMEP_std = sqrt((1 / (N–1)) × ∑(PMEP[N] – PMEP_ave)2) 	 # sqrt: square root

N:					    Number of cycles
PMEP:			   PMEP (kPa) (calculated value)
PMEP_ave:	 Averaged PMEP (kPa) (calculated value)

55.	 PMEP_cov
Rate of change in PMEP (%)

PMEP_cov = (PMEP_std / PMEP_ave) × 100

PMEP_std:		 Standard deviation of PMEP (kPa) (calculated value)
PMEP_ave:	 Averaged PMEP (kPa) (calculated value)

56.	 PMEP_Cy[N]
Averaged PMEP of all cylinders (kPa)

PMEP[N] = (1 / Cy) × ∑(IMEP[Cy, N])

Cy:		  Number of cylinders
N:			  Number of cycles
NMEP:	 PMEP (kPa) (calculated value)

57.	 PMEP_Cy_ave
Averaged PMEP of all cycles and cylinders (kPa)

PMEP_Cy_ave = (1 / N) × ∑(PMEP_Cy [N])

N:				   Number of cycles
PMEP_Cy:	Averaged PMEP of all cylinders (kPa) (calculated value)

7.1  Explanation of Equations
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58.	 Tθ [720,N], dQθ [720,N], Qθ [720,N]
Tθ [720,N]:	 Cylinder gas temperature (°C)
dQθ [720,N]:	 Rate of heat release (J/deg)
Qθ [720,N]:	 Amount of heat release (J)

(1)	 Gf
Mass of intake fuel (kg)

Gf = (Gfuel × (1 / 1000) × Cv) × ((60 × En_cyl) / Ne)

When fuel consumption and rpm are set to be measured and used in calculations:  
Gf[N] = (Gfuel_ave[N] × (1 / 1000) × Cv) × ((60 × En_cyl) / Ne_ave[N])

N:			  Number of cycles
Gfuel:	 Fuel consumption (cm3/sec) (manually input)
			�   Uses average fuel comsumption at each cycle when fuel consumption is set 

to be measured and used in calculations.
	 	 	 Gfuel_ave[N] = ave(Gfuel[720,N]) / Sn	 # ave: average value
			   Sn:	 Number of cylinders (used to calculate fuel consumption)
Cv:		  Specific gravity (manually input)
En_cyl:	 Engine cycle
	 	 	 4-cycle engine: En_cyl = 2
	 	 	 2-cycle engine: En_cyl = 1
Ne:		  Revolutions per minute (rpm) (manually input)
			�   Uses average rpm at each cycle when rpm is set to be measured and used in 

calculations.
	 	 	 Ne_ave[N] = ave(Ne[720,N])	 	 # ave: average value

(2)	 Ga
Mass of intake air (kg)

Ga = (Veff / 100) × (( Pa × (10000 / 98.0665) × Vst) / (29.27 × (Td + 273.16)))

When intake manifold pressure and intake manifold temperature are set to be measured 
and used in calculations:
Ga[N] = (Veff / 100) × (( Pitk_ave[N] × (10000 / 98.0665) × Vst) / (29.27 × (Td_ave + 
273.16)))

N:		 Number of cycles
Veff:	 Suction volumetric efficiency (%) (manually input)
Pa:	 Atmospheric pressure (kPa) (manually input)
	 	 �Uses Pitk_ave[N] (average intake manifold pressure at each cycle, calculated 

value) when intake manifold pressure is set to be measured and used in 
calculations.

Vst:	 Piston displacement (m3) (calculated value)
Td:	 Atmospheric temperature (°C) (manually input)
		�  Uses the average intake manifold temperature at each cycle when intake 

manifold temperature is set to be measured and used in calculations. 
	 	 Td_ave[N] = ave(Td[720,N])	 # ave: average value

7.1  Explanation of Equations
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(3)	 λs
Excess air factor

λs = Ga / (Thair × Gf)

When fuel consumption, rpm, intake manifold pressure, and intake manifold temperature 
are set to be measured and used in calculations:
λs[N] = Ga[N] / (Thair × Gf[N])

Ga:		  Mass of intake air (kg) (calculated value)
	 	 	 �Uses Ga[N] (mass of intake air at each cycle, calculated value) when intake 

manifold pressure and intake manifold temperature are set to be measured 
and used in calculations.

Thair:	 Theoretical air (= 14.512 kg)
Gf:		  Mass of intake fuel (kg) (calculated value)
	 	 	 �Uses Gf[N] (mass of intake fuel at each cycle, calculated value) when fuel 

consumption and rpm are set to be measured and used in calculations.

(4)	 Rr
Corrected gas constant

GN2 = (11.211 × λs) / (1 + 14.5977 × λs)
GO2 = (3.3867 × (λs-1) / (1 + 14.5977 × λs)
GCO2 = 3.1717 / (1 + 14.5977 × λs)
GH2O = 1.215 / (1 + 14.5977 × λs)
Rr = (30.26 × GN2) + (26.49 × GO2) + (19.26 × GCO2) + (47.06 × GH2O)

When fuel consumption, rpm, intake manifold pressure, and intake manifold temperature 
are set to be measured and used in calculations:
GN2[N] = (11.211 × λs[N]) / (1 + 14.5977 × λs[N])
GO2[N] = (3.3867 × (λs[N] - 1) / (1 + 14.5977 × λs[N])
GCO2[N] = 3.1717 / (1 + 14.5977 × λs[N])
GH2O[N] = 1.215 / (1 + 14.5977 × λs[N])
Rr[N] = (30.26 × GN2[N]) + (26.49 × GO2[N]) + (19.26 × GCO2[N]) + (47.06 × GH2O[N])

λs:	 Excess air factor (calculated value)
	 	 �Uses λs[N] (excess air factor at each cycle, calculated value) when fuel 

consumption, rpm, intake manifold pressure, and intake manifold temperature 
are set to be measured and used in calculations.

(5)	 Gr
Mass of remaining gas (kg)

Without a supercharger (manually selected)
Gr = (Pex × (10000 / 98.0655) × Vst) / (Rr × (Tex + 273.16) × (ε-1))

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature, 
exhaust gas pressure, and exhaust gas temperature are set to be measured and used in 
calculations:
Gr[N] = (Pex_ave[N] × (10000 / 98.0655) × Vst) / (Rr[N] × (Tex_ave[N]+273.16) × (α-1))

With a supercharger (manually selected)
α = ((Tturbin + 273.16) / 1.1 - (Tboost + 273.16)) / (Tturbin - Tboost)
(α= 0.9 when α > 0.9)
Gr = ((1 -α) × Pturbin × (10000 / 98.0655) × Vst) / (Rr ×(Tturbin + 273.16) × (ε-1))

7.1  Explanation of Equations
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When the fuel consumption, rpm, intake manifold pressure, intake manifold temperature, 
supercharger inlet pressure, supercharger inlet temperature, and boost temprature (intake 
manifold temperature) are set to be measured and used in calculations:  
α[N] = �((Tturbin_ave[N] + 273.16) / 1.1 - (Td_ave[N] + 273.16)) / (Tturbin_ave[N] - Td_

ave[N])
	 (α[N] = 0.9 when α[N] > 0.9)
Gr[N] = �((1 - α[N]) × Pturbin_ave[N] × (10000 / 98.0655) × Vst) / (Rr[N] × (Tturbin_ave[N] 

+ 273.16) × (ε-1))

Pex:		  Exhaust gas pressure (kPa) (manually input)
			�   Uses average exhaust gas pressure at each cycle when exhaust gas 

pressure is set to be measured and used in calculations.
	 	 	 Pex_ave[N] = ave(Pex[720,N])	 	 # ave: average value
Vst:		  Piston displacement (m3) (calculated value)
Rr:		  Corrected gas constant (calculated value)
	 	 	 �Uses Rr[N] (corrected gas constant for each cycle, calculated value) when 

fuel consumption, rpm, intake manifold pressure, and intake manifold 
temperature are set to be measured and used in calculations.

Tex:		  Exhaust gas temperature (°C) (manually input)
			�   Uses average exhaust gas temperature at each cycle when exhaust gas 

temperature is set to be measured and used in calculations.
	 	 	 Tex_ave[N] = ave(Tex[720,N])	 	 # ave: average value
ε:	 	 	 Compression ratio (manually input)
Tturbin:	Supercharger inlet temperature (°C) (manually input)
			�   Uses average supercharger inlet temperature at each cycle when 

supercharger inlet temperature is set to be measured and used in 
calculations.

	 	 	 Tturbin_ave[N] = ave(Tturbin[720,N])	 # ave: average value
Tboost:	 Boost temperature (°C) (manually)
			�   Uses average intake manifold temperature at each cycle when intake 

manifold temperature is set to be measured and used in calculations.
	 	 	 Td_ave[N] = ave(Td[720,N])	 	 # ave: average value
Pturbin:	Supercharger inlet pressure (kPa) (manually input)
			�   Uses average supercharger inlet pressure at each cycle when supercharger 

inlet pressure is set to be measured and used in calculations.
	 	 	 Pturbin_ave[N] = ave(Pturbin[720,N])	 # ave: average value

			 

Turbine Blower

5, 6
2, 3 1, 4

1. Boost pressure (Pt)
2. Supercharger inlet pressure (Pturbin)
3. Supercharger inlet temperature (Tturbin)
4. Boost temperature (Tboost)
5. Exhaust gas pressure (Pex)
6. Exhaust gas temperature (Tex)

7.1  Explanation of Equations
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(6)	� Initial Values (–360 CA (–180 CA for 2-Cycle Engines) – Point a: Start Point 
of Heat Release)

Repeatedly calculates from (6-1) to (6-6) for the interval as follows:
From θ = –360 CA (–180 CA for 2-cycle engine) to the crank angle (point a) at which dQθ 
changes to a positive value immediately before dQθ becomes dQmax (the maximum 
value of dQθ). 

(6-1)	Tθ [θ,N]
Gas temperature (K)

Gt0 = Ga+Gr
Gab = Ga+Gr × (1-Gf / Ga)
Grb = Gr × Gf / Ga
λamo = Gab / (Thair × Grb)
R0 = R –(0.14 /λamo)
Tθ [θ,N] = Pθ [θ,N] × (10000 / 98.0665) × Vθ [θ] / (Gt0 × R0)

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature, 
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake 
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be 
measured and used in calculations:  
Gt0[N] = Ga[N] + Gr[N]
Gab[N] = Ga[N] + Gr [N] × (1 - Gf[N] / Ga[N])
Grb[N] = Gr[N] × Gf[N] / Ga[N]
λamo[N] = Gab[N] / (Thair × Grb[N])
R0[N] = R –(0.14 /λamo[N])
Tθ [θ,N] = Pθ [θ,N] × (10000 / 98.0665) × Vθ [θ] / (Gt0[N] × R0[N])

Gt0:		  Total mass of gas (kg)
Ga:		  Mass of intake air (kg) (calculated value)
	 	 	 �Uses Ga[N] (mass of intake air at each cycle, calculated value) when intake 

manifold pressure and intake manifold temperature are set to be measured 
and used in calculations.

Gr:		  Mass of remaining gas (kg) (manually input)
	 	 	 �Uses Gr[N] (mass of remaining gas at each cycle, calculated value) when fuel 

consumption, rpm, intake manifole pressure, intake manifold temperature, 
exhaust gas pressure, exhaust gas temperature, supercharger inlet pressure, 
supercharger inlet temperature, and boost temperature (intake manifold 
temperature) are set to be measured and used in calculations.

Gf:		  Mass of intake fuel (kg) (calculated value)
	 	 	 �Uses Gf[N] (mass of intake fuel at each cycle, calculated value) when fuel 

consumption and rpm are set to be measured and used in calculations.
λamo:	 Average excess air factor
Thair:	 Theoretical air (= 14.512 kg)
R:			  Gas constant (= 29.27) (×9.80665 J/kg.K) (manually input)
Pθ:	 	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)
Vθ:	 	 Piston displacement (m3) (calculated value)

7.1  Explanation of Equations
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(6-2)	κθ [θ,N]
Ratio of specific heat

κθ [θ,N] = 1.4373 - 1.318 × 10-4 × Tθ [θ,N] + 3.12 × 10-8 × Tθ [θ,N]2 - 4.8 × 10-2 / λamo

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature, 
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake 
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be 
measured and used in calculations:  
κθ [θ,N] = 1.4373 - 1.318 × 10-4 × Tθ [θ,N] + 3.12 × 10-8 × Tθ [θ,N]2 - 4.8 × 10-2 / λamo[N]

Tθ:	 	 Gas temperature (K) (calculated value)
λamo:	 Average excess air factor (calculated value)
	 	 	 �Uses λamo[N] (average excess air factor at each cycle, calculated value) 

when fuel consumption, rpm, intake manifold pressure, intake manifold 
temperature, supercharger inlet pressure, supercharger inlet temperature, 
boost temperature (intake manifold temperature), exhaust gas pressure, and 
exhaust gas temperature are set to be measured and used in calculations.

(6-3)	dQreciθ [θ,N]
Rate of heat release (received heat) (J/deg)

dQreciθ [θ,N] = �κθ [θ,N] / (κθ [θ,N] - 1) × Pθ [θ,N] × 1000.0 × dVθ [θ] + 1 / (κθ [θ,N] - 1) × 
dPθ [θ,N] × 1000.0 × Vθ [θ]

κθ:	 Rate of specific heat (calculated value)
Pθ:	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)
dVθ:	 Rate of cylinder volume increase (m3/deg) (calculated value)
Vθ:	 Piston displacement (m3) (calculated value)
dPθ:	 Rate of cylinder pressure rise (kPa/deg) (calculated value)

(6-4)	dQwiθ
Rate of heat release (heat loss) (J/deg)

When taking heat loss into account (manually select)
Cm = 2 × S × Ne / 60
Sh = B2 × pi / 4
Sp = PistHr × Sh
Fθ [θ] = (Vθ [θ] / Sh) × pi × B
dQwigθ [θ,N] = 256 × B-0.124 × (Cm × Pθ [θ,N] / (10000 / 98.0665))0.786 × (Tθ [θ,N]-0.525)
Twall_K = Twall + 273.16
dQwislθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(Twall_K / 100)4) / (Tθ [θ,N]-Twall_K)
TwallH_K = TwallH + 273.16
dQwishθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallH_K / 100)4) / (Tθ [θ,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwispθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallP_K / 100)4) / (Tθ [θ,N] - TwallP_K)
dQwiθ [θ,N] = �(((dQwigθ [θ,N] + dQwislθ [θ,N]) × Fθ [θ] × (Tθ [θ,N] - Twall_K) + dQwigθ 

[θ,N] + dQwishθ [θ,N]) × Sh × (Tθ [θ,N] - TwallH_K) + dQwigθ [θ,N] + 
dQwispθ [θ,N]) × Sp × (Tθ [θ,N] - TwallP_K)) / (6 × Ne × 3600)) × 4.18605 
× 103 

7.1  Explanation of Equations
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When rpm is set to be measured and used in calculations:
Cm[N] = 2 × S × Ne_ave[N] / 60
Sh = B2 × pi / 4
Sp = PistHr × Sh
Fθ [θ] = (Vθ [θ] / Sh) × pi × B
dQwigθ [θ,N] = 256 × B-0.124 × (Cm[N] × Pθ [θ,N] / (10000 / 98.0665))0.786 × (Tθ [θ,N]-0.525)
Twall_K = Twall + 273.16
dQwislθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(Twall_K / 100)4) / (Tθ [θ,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwishθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallH_K / 100)4) / (Tθ [θ,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwispθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallP_K / 100)4) / (Tθ [θ,N] - TwallP_K)
dQwiθ [θ,N] = �(((dQwigθ [θ,N] + dQwislθ [θ,N]) × Fθ [θ] × (Tθ [θ,N] - Twall_K) + dQwigθ 

[θ,N] + dQwishθ [θ,N]) × Sh × (Tθ [θ,N] - TwallH_K) + dQwigθ [θ,N] + 
dQwispθ [θ,N]) × Sp × (Tθ [θ,N] - TwallP_K)) / (6 × Ne_ave[N] × 3600)) × 
4.18605 × 103 

When not taking heat loss into account
dQwiθ [θ] = 0

Cm:		  Average piston speed (m/s)
	 	 	 �Uses Cm[N] (average piston speed at each cycle) when rpm is set to be 

measured and used in calculations.
S:			  Stroke (m) (manually input)
Ne:		  Revolutions per minute (rpm) (manually input)
	 	 	 �Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be measured 

and used in calculations.
	 	 	 Ne_ave[N] = ave(Ne[720,N])	 # ave: average value
Sh:		  Cylinder cross-sectional area (m2)
B:			  Bore (m) (manually input)
pi:			  The circular constant
Sp:		  Area of the piston head (m2) (manually input)
PistHr:	 Piston head ratio (manually input)
Fθ:	 	 Cylinder clearance (m2)
Vθ:	 	 Piston displacement (m3) (calculated value)
Twall:	 Cylinder wall temperature (°C) (manually input)
Tθ:	 	 Gas temperature (K) (calculated value)
TwallH:	 Cylinder head wall temperature (°C) (manually input)
TwallP:	 Piston head wall temperature (°C) (manually input)

(6-5)	dQθ
Rate of heat release (J/deg)

dQθ [θ,N] = dQreciθ [θ,N] + dQwiθ [θ,N]

dQreciθ:	 Rate of heat release (received heat) (J/deg) (calculated value)
dQwiθ:	 	 Rate of heat release (heat loss) (J/deg) (calculated value)

(6-6)	Qθ [θ,N]
Amount of heat release (J)

Qθ [θ,N] = 0

7.1  Explanation of Equations
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(7)	� Combustion Period (Point a: Start Point of Heat Release to Point b: End 
Point of Heat Release)

Repeatedly calculates from (7-1) to (7-6) until the following conditions are satisfied: From 
θ= point a until the crank angle at which dQθ changes to a negative value immediately 
after dQθ becomes dQmax (the maximum value of dQθ). Use the value for Qprevθ in (7-5) 
in (7-1). 

Q0 = Gf × Hu
Qprevθ = 0

Hu:		  Amount of heat release at the lowest position (J/kg) (manually input)
Gf:		  Mass of intake fuel (kg) (calculated value)
Qprevθ:	Amount of heat release at the current angle (J)

(7-1)	Tθ
Gas temperature (K)

Gab = Ga + Gr × (1 - Gf / Ga)
Grb = Gr × Gf / Ga
Gt0θ = Gab + Grb + Qprevθ / Hu
λamoθ= Gab / (Thair × (Grb + Qprevθ / Hu))
ROθ= R -(0.14 / λamoθ)
Tθ [θ,N] = Pθ [θ,N] × (10000 / 98.0665) × Vθ [θ] / (Gt0θ × R0θ)

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature, 
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake 
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be 
measured and used in calculations:  
Gab[N] = Ga[N] + Gr[N] × (1 - Gf[N] / Ga[N])
Grb[N] = Gr[N] × Gf[N] / Ga[N]
Gt0θ [N] = Gab[N] + Grb[N] + Qprevθ / Hu
λamoθ[N] = Gab[N] / (Thair × (Grb[N] + Qprevθ / Hu))
R0θ[N] = R -(0.14 / λamoθ[N])
Tθ [θ,N] = Pθ [θ,N] × (10000 / 98.0665) × Vθ [θ] / (Gt0θ[N] × ROθ[N])

Ga:		  Mass of intake air (kg) (calculated value)
	 	 	 �Uses Ga[N] (mass of intake air at each cycle, calculated value) when intake 

manifold pressure and intake manifold temperature are set to be measured 
and used in calculations.

Gr:		  Mass of remaining gas (kg) (calculated value)
	 	 	 �Uses Gr[N] (mass of remaining gas at each cycle, calculated value) when fuel 

consumption, rpm, intake manifole pressure, intake manifold temperature, 
exhaust gas pressure, exhaust gas temperature, supercharger inlet pressure, 
supercharger inlet temperature, and boost temperature (intake manifold 
temperature) are set to be measured and used in calculations.

Gf:		  Mass of intake fuel (kg) (calculated value)
	 	 	 �Uses Gf[N] (mass of intake fuel at each cycle, calculated value) when fuel 

consumption and rpm are set to be measured and used in calculations.
Qprev:	 Amount of heat release at the current angle (J) (calculated value)
Hu:		  Amount of heat release at the lowest position (J/kg) (manually input)
Thair:	 Theoretical air (= 14.512 kg)
R:			  Gas constant (= 29.27) (× 9.80665 J/kg.K) (manually input)
Pθ:	 	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)
Vθ:	 	 Piston displacement (m3) (calculated value)

7.1  Explanation of Equations
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(7-2)	κθ [θ,N]
Ratio of specific heat

κθ [θ,N] = 1.4373 - 1.318 × 10-4 × Tθ [θ,N] + 3.12 × 10-8 × Tθ [θ,N]2 - 4.8 × 10-2 / λamoθ

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature, 
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake 
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be 
measured and used in calculations:  
κθ [θ,N] = �1.4373 - 1.318 × 10-4 × Tθ [θ,N] + 3.12 × 10-8 × Tθ [θ,N]2 - 4.8 × 10-2 / 

λamoθ[N]

Tθ:	 	 Gas temperature (K) (calculated)
λamoθ:	 Average excess air factor (calculated value)
	 	 	 �Uses λamo[N] (average excess air factor at each cycle, calculated value) 

when fuel consumption, rpm, intake manifold pressure, intake manifold 
temperature, supercharger inlet pressure, supercharger inlet temperature, 
boost temperature (intake manifold temperature), exhaust gas pressure, and 
exhaust gas temperature are set to be measured and used in calculations.

(7-3)	dQreci
Rate of heat release (received heat) (J/deg)

dQreci[θ,N] = �κθ [θ,N] / (κθ [θ,N] - 1) × Pθ [θ,N] × 1000.0 × dVθ [θ] + 1 / (κθ [θ,N] - 1) × 
dPθ [θ,N] × 1000.0 × Vθ [θ]

κθ:	 Ratio of specific heat
Pθ:	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)
Vθ:	 Piston displacement (m3) (calculated value)

(7-4)	dQwiθ [θ,N]
Rate of heat release (heat loss) (J/deg)

When taking heat loss into account (manually select)
Cm = 2 × S × Ne / 60
Fθ [θ] = (Vθ [θ] / Sh) × pi × B
dQwigθ [θ,N] = 256 × B-0.124 × (Cm × Pθ [θ,N] / (10000 / 98.0665))0.786 × (Tθ [θ,N]-0.525)
Twall_K = Twall + 273.16
dQwislθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(Twall_K / 100)4) / (Tθ [θ,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwishθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(wallH_K / 100)4) / (Tθ [θ,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwispθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallP_K / 100)4) / (Tθ [θ,N] - TwallP_K)
dQwiθ [θ,N] = �(((dQwigθ [θ,N] + dQwislθ [θ,N]) × Fθ [θ] × (Tθ [θ,N] - Twall_K) + 

(dQwigθ [θ,N] + dQwishθ [θ,N]) × Sh × (Tθ [θ,N] - TwallH_K) + (dQwigθ [θ,N] 
+ dQwispθ [θ,N]) × Sp × (Tθ [θ,N] - TwallP_K)) / (6 × Ne × 3600)) × 4.18605 
× 103 

7.1  Explanation of Equations
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When rpm is set to be measured and used in calculations:  
Cm[N] = 2 × S × Ne_ave[N] / 60
Fθ [θ] = (Vθ [θ] / Sh) × pi × B
dQwigθ [θ,N] = 256 × B-0.124 × (Cm[N] × Pθ [θ,N] / (10000 / 98.0665))0.786 × (Tθ [θ,N]-0.525)
Twall_K = Twall + 273.16
dQwislθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(Twall_K / 100)4) / Tθ [θ,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwishθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallH_K / 100)4) / (Tθ [θ,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwispθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallP_K / 100)4) / (Tθ [θ,N] - TwallP_K)
dQwiθ [θ,N] = �(((dQwigθ [θ,N] + dQwislθ [θ,N]) × Fθ [θ] × (Tθ [θ,N] - Twall_K)+ (dQwigθ 

[θ,N] + dQwishθ [θ,N]) × Sh × (Tθ [θ,N] - TwallH_K) + (dQwigθ [θ,N] + 
dQwispθ [θ,N]) × Sp × (Tθ [θ,N] - TwallP_K)) / (6 × Ne_ave[N] × 3600)) × 
4.18605 × 103 

When not taking heat loss into account
dQwi[θ] = 0

Cm:		  Average piston speed (m/s)
	 	 	 �Uses Cm[N] (average piston speed at each cycle) when rpm is set to be 

measured and used in calculations.
S:			  Stroke (m) (manually input)
Ne:		  Revolutions per minute (rpm) (manually input)
	 	 	 �Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be measured 

and used in calculations.
	 	 	 Ne_ave[N] = ave(Ne[720,N])	 	 # ave: average value
Vθ:	 	 Piston displacement (m3) (calculated value)
Sh:		  Cylinder cross-sectional area (m2)
B:			  Bore (m) (manually input)
pi:			  The circular constant
Fθ:	 	 Cylinder clearance (m2)
Sp:		  Area of the piston head (m2) (manually input)
Twall:	 Cylinder wall temperature (°C) (manually input)
Tθ:	 	 Gas temperature (K) (calculated value)
TwallH:	 Cylinder head wall temperature (°C) (manually input)
TwallP:	 Piston head wall temperature (°C) (manually input)

(7-5)	dQθ
Rate of heat release (J/deg)

dQθ [θ,N] = dQreciθ [θ,N] + dQwiθ [θ,N]
Qprevθ = Qprevθ + dQθ [θ,N] × res
	 When Qprevθ > Q0, Qprevθ = Q0.
	 For dQθ ≤ 0, do not add.

dQreciθ:	 Rate of heat release (received heat) (J/deg) (calculated value)
dQwiθ:	 	 Rate of heat release (heat loss) (J/deg) (calculated value)
res:			   Angle resolution (manually input)
Qprevθ:		 Amount of heat release at the current angle (J)
Q0:			   = Gf × Hu
	 	 	 	 �Uses Gf[N] (mass of intake fuel at each cycle, calculated value) when fuel 

consumption and rpm are set to be measured and used in calculations.

7.1  Explanation of Equations
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(7-6)	Qθ [θ,N]
Amount of heat release (J)

Qθ [θ,N] = Qprevθ

Qprevθ:	Amount of heat release at the current angle (J)

(8)	� From the End Point of Heat Release (Point b: End Point of Heat Release to 
+360 CA (+180 CA for 2-Cycle Engines) )

Repeatedly calculates from (8-1) to (8-6) from θ = point b to +360 CA (+180 CA for 
2-cycle engines) 

Q0 = Qθ [b,N]

Qθ [b,N]:	 Amount of heat release at point b (J)

(8-1)	Tθ
Gas temperature (K)

Gab = Ga+Gr × (1-Gf / Ga)
Grb = Gr × Gf / Ga
Gt0 = Gab + Grb + Q0 / Hu
λamo = Gab / (Thair × (Grb + Q0 / Hu)
R0 = R -(0.14 / λamo)
Tθ [θ,N] = Pθ [θ,N] × (10000 / 98.0665) × Vθ [θ] / (Gt0 × R0)

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature, 
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake 
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be 
measured and used in calculations:  
Gab[N] = Ga[N] + Gr[N] × (1 - Gf[N] / Ga[N])
Grb[N] = Gr[N] × Gf[N] / Ga[N]
Gt0[N] = Gab[N] + Grb[N] + Q0 / Hu
λamo[N] = Gab[N] / (Thair × (Grb[N] + Q0 / Hu)
R0[N] = R -(0.14 / λamo[N])
Tθ [θ,N] = Pθ [θ,N] × (10000 / 98.0665) × Vθ [θ] / (Gt0[N] × R0[N])

Ga:		  Mass of intake air (kg) (calculated value)
	 	 	 �Uses Ga[N] (mass of intake air at each cycle, calculated value) when intake 

manifold pressure and intake manifold temperature are set to be measured 
and used in calculations.

Gr:		  Mass of remaining gas (kg) (calculated value)
	 	 	 �Uses Gr[N] (mass of remaining gas at each cycle, calculated value) when fuel 

consumption, rpm, intake manifole pressure, intake manifold temperature, 
exhaust gas pressure, exhaust gas temperature, supercharger inlet pressure, 
supercharger inlet temperature, and boost temperature (intake manifold 
temperature) are set to be measured and used in calculations.

Gf:		  Mass of intake fuel (kg) (calculated value)
	 	 	 �Uses Gf[N] (mass of intake fuel at each cycle, calculated value) when fuel 

consumption and rpm are set to be measured and used in calculations.
Q0:		  Amount of heat release at point b (J) (calculated value)
Hu:		  Amount of heat release at the lowest position (J/kg) (manually input)
Thair:	 Theoretical air (= 14.512 kg)
R:			  Gas constant (= 29.27) (× 9.80665 J/kg K) (manually input)
Pθ:	 	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)
Vθ:	 	 Piston displacement (m3) (calculated value)

7.1  Explanation of Equations
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(8-2)	κθ [θ,N]
Ratio of specific heat

κθ [θ,N] = 1.4373 - 1.318 × 10-4 × Tθ [θ,N] + 3.12 × 10-8 × Tθ [θ,N]2- 4.8 × 10-2 / λamo

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature, 
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake 
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be 
measured and used in calculations:
κθ [θ,N] = 1.4373 - 1.318 × 10-4 × Tθ [θ,N] + 3.12 × 10-8 × Tθ [θ,N]2 - 4.8 × 10-2 / λamo[N]

Tθ:	 	 Gas temperature (K) (calculated value)
λamo:	 Average excess air factor (calculated value)
	 	 	 �Uses λamo[N] (average excess air factor at each cycle, calculated value) 

when fuel consumption, rpm, intake manifold pressure, intake manifold 
temperature, supercharger inlet pressure, supercharger inlet temperature, 
boost temperature (intake manifold temperature), exhaust gas pressure, and 
exhaust gas temperature are set to be measured and used in calculations.

(8-3)	dQreci
Rate of heat release (received heat) (J/deg)

dQreci [θ,N] = �κθ [θ,N] / (κθ [θ,N] -1) × Pθ [θ,N] × 1000.0 × dVθ [θ] + 1 / (κθ [θ,N] -1) × 
dPθ [θ,N] × 1000.0 × Vθ [θ]

vθ:	 Ratio of specific heat
Pθ:	 Cylinder pressure (kPa) after absolute pressure correction (calculated value)
Vθ:	 Piston displacement (m3) (calculated value)

(8-4)	dQwiθ [θ,N]
Rate of heat release (heat loss) (J/deg)

When taking heat loss into account (manually select)
Cm = 2 × S × Ne / 60
Fθ [θ] = (Vθ [θ] / Sh) × pi × B
dQwigθ [θ,N] = 256 × B-0.124 × (Cm × Pθ [θ,N] / (10000 / 98.0665))0.786 × (Tθ [θ,N]-0.525)
Twall_K = Twall + 273.16
dQwislθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(Twall_K / 100)4) / (Tθ [θ,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwishθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallH_K / 100)4) / (Tθ [θ,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwispθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallP_K / 100)4) / (Tθ [θ,N] - TwallP_K)
dQwiθ [θ,N] = �(((dQwigθ [θ,N] + dQwislθ [θ,N]) × Fθ [θ] × (Tθ [θ,N] - Twall_K) + 

(dQwigθ [θ,N] + dQwishθ [θ,N]) × Sh × (Tθ [θ,N] - TwallH_K) + (dQwigθ [θ,N] 
+ dQwispθ [θ,N]) × Sp × (Tθ [θ,N] - TwallP_K)) / (6 × Ne × 3600)) × 4.18605 
× 103 

7.1  Explanation of Equations
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When rpm is set to be measured and used in calculations:  
Cm[N] = 2 × S × Ne_ave[N] / 60
Fθ [θ] = (Vθ [θ] / Sh) × pi × B
dQwigθ [θ,N] = 256 × B-0.124 × (Cm[N] × Pθ [θ,N] / (10000 / 98.0665))0.786 × (Tθ [θ,N]-0.525)
Twall_K = Twall + 273.16
dQwislθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(Twall_K / 100)4) / (Tθ [θ,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwishθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallH_K / 100)4) / (Tθ [θ,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwispθ [θ,N] = 0.362 × ((Tθ [θ,N] / 100)4 -(TwallP_K / 100)4) / (Tθ [θ,N] - TwallP_K)
dQwiθ [θ,N] = �(((dQwigθ [θ,N] + dQwislθ [θ,N]) × Fθ [θ] × (Tθ [θ,N] - Twall_K) + 

(dQwigθ [θ,N] + dQwishθ [θ,N]) × Sh × (Tθ [θ,N] - TwallH_K) + (dQwigθ [θ,N] 
+ dQwispθ [θ,N]) × Sp × (Tθ [θ,N] - TwallP_K)) / (6 × Ne_ave[N] × 3600)) 
× 4.18605 × 103 

When not taking heat loss into account
dQwi[θ] = 0

Cm:		  Average piston speed (m/s)
	 	 	 �Uses Cm[N] (average piston speed at each cycle) when rpm is set to be 

measured and used in calculations.
S:			  Stroke (m) (manually input)
Ne:		  Revolutions per minute (rpm) (manually input)
	 	 	 �Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be measured 

and used in calculations.
	 	 	 Ne_ave[N] = ave(Ne[720,N])	 # ave: average value
Vθ:	 	 Cylinder volume (m3) (calculated value)
Sh:		  Cylinder cross-sectional area (m2)
B:			  Bore (m) (manually input)
pi:			  The circular constant
Fθ:	 	 Cylinder clearance (m2)
Sp:		  Area of the piston head (m2) (manually input)
Twall:	 Cylinder wall temperature (°C) (manually input)
Tθ:	 	 Gas temperature (K) (calculated value)
TwallH:	 Cylinder head wall temperature (°C) (manually input)
TwallP:	 Piston head wall temperature (°C) (manually input)

(8-5)	dQθ
Rate of heat release (J/deg)

dQθ [θ,N] = dQreciθ [θ,N] + dQwiθ [θ,N]

dQreciθ:	 Rate of heat release (received heat) (J/deg) (calculated value)
dQwiθ:	 	 Rate of heat release (heat loss) (J/deg) (calculated value)

(8-6)	Qθ [θ,N]
Amount of heat release (J)

Qθ [θ,N] = Q0

Q0:	 Amount of heat release at point b (J)

7.1  Explanation of Equations
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(9)	 Tθ
Cylinder gas temperature (°C)  

Tθ [720,N] = Tθ [720,N] - 273.16

Tθ:	 Gas temperature (K) (calculated value)

59.	 Tθ ave[720]
Average cylinder gas temperature (°C)

Tθ ave[720] = (1 / N) × ∑(Tθ [720,N])

N:		 Number of cycles
Tθ:	 Cylinder gas temperature (°C) (calculated value)

60.	 Tmax[N]
Maximum cylinder gas temperature (°C)

Tmax[N] = max(Tθ [720,N])

N:		 Number of cycles
Tθ:	 Cylinder gas temperature (°C) (calculated value)

61.	 θTmax[N]
Crank angle (CA) at maximum cylinder gas temperature

θTmax[N] = pos(Tθ [720,N])
	 # pos: crank angle at the maximum cylinder gas temperature

N:		 Number of cycles
Tθ:	 Cylinder gas temperature (°C) (calculated value)

62.	 Tmax_ave
Averaged maximum cylinder gas temperature (°C)

Tmax_ave = (1 / N) × ∑(Tmax[N])

N:		 Number of cycles
Tmax:	 Maximum cylinder gas temperature (°C) (calculated value)

63.	 Tmax_std
Standard deviation of maximum cylinder gas temperature (°C)

Tmax_std = sqrt((1 / (N–1)) × ∑(Tmax [N] – Tmax_ave)2) 	 # sqrt: square root

N:				   Number of cycles
Tmax:		  Maximum cylinder gas temperature (°C) (calculated value)
Tmax_ave:	Averaged maximum cylinder gas temperature (°C) (calculated value)

64.	 Tmax_cov
Rate of change in maximum cylinder gas temperature (%)

Tmax_cov = (Tmax_std / Tmax_ave) × 100

Tmax_std:	 �Standard deviation of maximum cylinder gas temperature (°C) (calculated 
value)

Tmax_ave:	Averaged maximum cylinder gas temperature (°C) (calculated value)

7.1  Explanation of Equations
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65.	 dQθ ave [720]
Average rate of heat release (J/deg)

dQθ ave[720] = (1 / N) × ∑(dQθ [720,N])

N:		 Number of cycles
dQθ:	Rate of heat release (J/deg) (calculated value)

66.	 dQmax[N]
Maximum rate of heat release (J/deg)

dQmax[N] = max(dQθ [720,N])
	 # max: �Indicates the maximum value within the manually input search range of the 

maximum rate of release.

N:		 Number of cycles
dQθ:	Rate of heat release (J/deg) (calculated value)

67.	 θdQmax[N] 
Crank angle at maximum rate of heat release (CA)

θdQmax[N] = pos(dQθ [720,N])	 # pos: crank angle at maximum rate of heat release

N:		 Number of cycles
dQθ:	Rate of heat release (J/deg) (calculated value)

68.	 θdQmax_ave
Averaged crank angle at maximum rate of heat release (CA)

θdQmax_ave = (1 / N) × ∑(θdQmax [N])

N:				   Number of cycles
vdQmax:	 Crank angle at maximum rate of heat release (CA) (calculated value)

69.	 dQmax_ave
Averaged maximum rate of heat release (J/deg)

dQmax_ave = (1 / N) × ∑(dQmax [N])

N:			  Number of cycles
dQmax:	Maximum rate of heat release (J/deg) (calculated value)

70.	 dQmax_std
Standard deviation of maximum rate of heat release (J/deg)

dQmax_std = sqrt((1 / (N–1)) × ∑(dQmax [N] – dQmax_ave)2) 	 # sqrt: square root

N:					    Number of cycles
dQmax:			  Maximum rate of heat release (J/deg) (calculated value)
dQmax_ave:	 Averaged maximum rate of heat release (J/deg) (calculated value)

71.	 dQmax_cov
Rate of change (%) in maximum rate of heat release

dQmax_cov = (dQmax_std / dQmax_ave) × 100

dQmax_std:	 �Standard deviation of the maximum rate of heat release (J/deg) 
(calculated value)

dQmax_ave:	 Averaged maximum rate of heat release (J/deg) (calculated value)

7.1  Explanation of Equations
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72.	 Qθ ave[720]
Average amount of heat release (J)

Qθ ave[720] = (1 / N) × ∑(Qθ [720,N])

N:		 Number of cycles
Qθ:	 Amount of heat release (J) (calculated value)

73.	 Qmax[N]
Maximum amount of heat release (J)

Qmax[N] = max(Qθ [720,N])	 # max: maximum value

N:		 Number of cycles
Qθ:	 Amount of heat release (J) (calculated value)

74.	 θQmax[N]
Crank angle (CA) at maximum amount of heat release

θQmax[N] = pos(Qθ [720,N])
	 # pos: crank angle at the maximum amount of heat release

N:		 Number of cycles
Qθ:	 Amount of heat release (J) (calculated value)

75.	 θQmax_ave
Averaged crank angle at maximum amount of heat release (CA)

θQmax_ave = (1 / N) × ∑(θQmax [N])

N:			  Number of cycles
θQmax:	Crank angle at maximum amount of heat release (CA) (calculated value)

76.	 Qmax_ave
Averaged maximum amount of heat release (J)

Qmax_ave = (1 / N) × ∑(Qmax[N])

N:			  Number of cycles
Qmax:	 Maximum amount of heat release (J) (calculated value)

77.	 Qmax_std
Standard deviation of maximum amount of heat release (J)

Qmax_std = sqrt((1 / (N–1)) × ∑(Qmax[N] – Qmax_ave)2) 	 # sqrt: square root

N:					    Number of cycles
Qmax:			   Maximum amount of heat release (J) (calculated value)
Qmax_ave:	 Averaged maximum amount of heat release (J) (calculated value)

78.	 Qmax_cov
Rate of change (%) in maximum amount of heat release

Qmax_cov = (Qmax_std / Qmax_ave) × 100

Qmax_std:		 �Standard deviation of maximum amount of heat release (J) (calculated 
value)

Qmax_ave:	 Averaged maximum amount of heat release (J) (calculated value)

7.1  Explanation of Equations
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79.	 Qab
Amount of heat release during the combustion period (J)

Qab[N] = Qθ [b,N]
	 Amount of heat release at point b at each cycle (sum from point a to point b at each 

cycle)

N:		 Number of cycles
Qθ:	 Amount of heat release (J) (calculated value)
b:	 	 �End point of combustion. Crank angle (CA) at which the value of dQθ is changed 

to a negative value immediately after dQmax (calculated value)

80.	 Qab_ave
Average amount of heat release during the combustion period (J)

Qab_ave = (1 / N) × Qab[N]

N:		 Number of cycles
Qab:	Amount of heat release during the combustion period (J) (calculated value)

81.	 RHθ [720,N]
Combustion mass rate (%)

RHθ [720, N] = Qθ [720,N] / Qab[N]

N:		 Number of cycles
Qθ:	 Amount of heat release (J) (calculated value)
Qab:	The calculated sum (J) from point a to point b at each cycle

82.	 RHθ ave[720]
Average combustion mass rate (%)

RHθ ave[720] = (1 / N) × ∑(RHθ [720,N])

N:		 Number of cycles
RHθ:	Combustion mass rate (%) (calculated value)

83.	 θRH[N] 
Crank angle at combustion mass rate N1 % (CA)
(the crank angle such that the combustion mass rate is N1 %)

θRH[N] = floor(round(RHθ [720,N]), ratio)
	 # floor: �the angle whereby RHθ is greater than ratio (depending on the angular 

resolution)
	 # round: round to 1 digit after the decimal place

N:		 Number of cycles
RHθ:	Combustion mass rate (%) (calculated value)
ratio:	Ratio for judging angle of combustion mass rate N1 % (%) (manually input)

84.	 θRH_ave
Averaged angle at combustion mass rate N1 % (CA)

θRH_ave = (1 / N) × ∑(θRH[N])

N:		 Number of cycles
θRH:	Angle at combustion mass rate N1 % (CA) (calculated value)

7.1  Explanation of Equations
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85.	 θRH_std
Standard deviation of angle at combustion mass rate N1 % (CA)

θRH_std = sqrt((1 / (N – 1)) × ∑(θRH[N] – θRH_ave)2)	 # sqrt: square root

N:				   Number of cycles
θRH:		 	 Angle at combustion mass rate N1 % (CA) (calculated value)
θRH_ave:	 Averaged angle at combustion mass rate N1 % (CA) (calculated value)

86.	 θRH_cov
Rate of change in angle at combustion mass rate N1 % (CA)

θRH_cov = (θRH_std / θRH_ave) × 100

θRH_std:	 �Standard deviation of angle at combustion mass rate N1 % (CA) 
(calculated value)

θRH_ave:	 Averaged angle at combustion mass rate N1 % (CA) (calculated value)

87.	 θRH2[N] 
Crank angle at combustion mass rate N2 % (CA)
(the crank angle such that the combustion mass rate is N2 %)

θRH2[N] = floor(round(RHθ [720,N]), ratio2)
	 # floor: �the angle whereby RHθ is greater than ratio2 (depending on the angular 

resolution)
	 # round: round to 1 digit after the decimal place

N:			  Number of cycles
RHθ:		 Combustion mass rate (%) (calculated value)
ratio2:	 Ratio for judging angle of combustion mass rate N2 % (%) (manually input)

88.	 θRH2_ave 
Averaged angle at combustion mass rate N2 % (CA)

θRH2_ave = (1 / N) × ∑(θRH2[N])

N:			  Number of cycles
θRH2:	 Angle at combustion mass rate N2 % (CA) (calculated value)

89.	 θRH2_std
Standard deviation of angle at combustion mass rate N2 % (CA)

θRH2_std = sqrt((1 / (N – 1)) × ∑(θRH2[N] – θRH2_ave)2)	 # sqrt: square root

N:				   Number of cycles
θRH2:	 	 Angle at combustion mass rate N2 % (CA) (calculated value)
θRH2_ave:	Averaged angle at combustion mass rate N2 % (CA) (calculated value)

90.	 θRH2_cov
Rate of change in angle at combustion mass rate N2 % (CA)

θRH2_cov = (θRH2_std / θRH2_ave) × 100

θRH2_std:	�Standard deviation of angle at combustion mass rate N2 % (CA) (calculated 
value)

θRH2_ave:	Averaged angle at combustion mass rate N2 % (CA) (calculated value)

7.1  Explanation of Equations
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91.	 θRH3[N] 
Crank angle at combustion mass rate N3 % (CA)
(the crank angle such that the combustion mass rate is N3 %)

θRH3[N] = floor(round(RHθ [720,N]), ratio3)
	 # floor: �the angle whereby RHθ is greater than ratio3 (depending on the angular 

resolution)
	 # round: round to 1 digit after the decimal place 

N:			  Number of cycles
RHθ:		 Combustion mass rate (%) (calculated value)
ratio3:	 Ratio for judging angle of combustion mass rate N3 % (%) (manually input)

92.	 θRH3_ave 
Averaged angle at combustion mass rate N3 % (CA)

θRH3_ave = (1 / N) × ∑(θRH3[N])

N:			  Number of cycles
θRH3:	 Angle at combustion mass rate N3 % (CA) (calculated value)

93.	 θRH3_std
Standard deviation of angle at combustion mass rate N3 % (CA)

θRH3_std = sqrt((1 / (N – 1)) × ∑(θRH3[N] – θRH3_ave)2)	 # sqrt: square root

N:				   Number of cycles
vRH3:		  Angle at combustion mass rate N3 % (CA) (calculated value)
θRH3_ave:	Averaged angle at combustion mass rate N3 % (CA) (calculated value)

94.	 θRH3_cov
Rate of change in angle at combustion mass rate N3 % (CA)

θRH3_cov = (θRH3_std / θRH3_ave) × 100

θRH3_std:	�Standard deviation of angle at combustion mass rate N3 % (CA) (calculated 
value)

θRH3_ave:	Averaged angle at combustion mass rate N3 % (CA) (calculated value)

95.	 PolYθ [720]
Polytropic index

PolYθ [720] = – (log10(Pθ ave[n–1] / Pθ ave[n]) / log10 (Vθ [n–1] / Vθ [n])) 
	 n = 0 to 719.  when n = 0, Polyθ = 1.

Pθ ave:	Average cylinder pressure (kPa)
Vv:		  Piston displacement (m3)

7.1  Explanation of Equations
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96.	 Vmax
Maximum piston displacement (m3)

When Clearance volume is selected on the Parameter Settings screen
Vmax = Vst + Vc
When Compression ratio is selected on the Parameter Settings screen
Vmax = Vst + (Vst / (Cr – 1))

Vst:	 Piston displacement (m3)
Vc:	 Clearance volume (m3)
Cr:	 Compression ratio (manually input)

97.	 chXθ ave[720]
Other signals (crank angle graph data)

chXθ ave[720] = (1 / N) × ∑(chX[720,N])

N:		 Number of cycles
chX:	 Measured value of chX

98.	 chXave[N]
Other signals (cycle graph data)

chXave[N] = ave(chX[720,N])	 # ave: average value

N:		 Number of cycles
chX:	 Measured value of chX

99.	 a_ave
Average start point of combustion (CA)

a_ave = (1 / N) × ∑a[N]

N:	Number of cycles
a:	 �Crank angle (CA) at which the value of dQθ is changed to a positive value 

immediately before dQmax (calculated value)
	 When manually input, the setting value is assumed to be point “a.” 

100.	b_ave
Average end point of combustion (CA)

b_ave = (1 / N) × ∑b[N]

N:	Number of cycles
b:	 �Crank angle (CA) at which the value of dQθ is changed to a negative value 

immediately after dQmax (calculated value)
	 When manually input, the setting value is assumed to be point “b.” 

7.1  Explanation of Equations
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8.1	 A List of Error Messages

Messages Description
Analysis results not saved. Save the results?
All calculated results will be discarded. OK to proceed? .
Settings take effect after system restart.
No unit selected.
Illegal setting value. The input value exceeded the upper or lower limit for 

the setting.
No Group ID was specified.
Failed to load the analysis conditions. The format of the analysis file (.ecp) is incorrect.
P1 channel assignment not set correctly.
Set P1 to CH1.
Application has already started. (Two simultaneous sessions 
prohibited.)
Cannot exit during monitoring. Please stop monitoring before exiting.
Unused channel cannot be assigned to a trigger.
The range defined by the start cycle and end cycle settings exceeds 
the number of effective cycles. Please reenter the values.
X axis range not entered correctly.
Y axis range not entered correctly.
Could not update network search settings.
Could not execute network search.
Could not acquire network information.
Please select a trigger type.
Please select a range.
Cannot start waveform check.
Cannot stop waveform check.
Cannot specify stroke type.
Cannot specify measurement information.
Cannot specify channel information.
Cannot specify trigger information.
Failed to create analysis work data.
Failed to acquire specified (ch/cycle) raw data.
Failed to acquire ASCII header information.
Failed to initialize calculation.
The default drive (*) may have insufficient free space.
Analysis results may not be able to be saved. OK to continue?
Start cycle cannot be greater than the end cycle.
Engine type different than during measurement. Force execution?
License is invalid. The license key information does not match the 

installation information.
The period of a trial is remaining XX days.
The period of a trial had finished.
"A license key is undetectable.  
Please push ""Retry"" button after connecting a usb-license-key.  
If the ""Cancel"" button is chosen, this software will be finished. "
This firmware version of DL850 series is not supported. 
The number of active channels exceeds the upper limit. No more than 16 channels can be input.

Chapter 8	 Error Messages
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Appendix 1	 Relationship between Number of 
Mounted Modules and Maximum 
Number of Measurable Cycles

The maximum number of measurable cycles varies as follows according to the set 
number of modules mounted in the DL850 series/SL1000 and the angular resolution 
setting. 

Max. measurable cycles
No. of modules 1 CA 0.5 CA 0.25 CA 0.1 CA
1 25000 12500 6250 2500
2 25000 12500 6250 2500
3 12500 6250 3125 1250
4 12500 6250 3125 1250
5 6250 3125 1562 625
6 6250 3125 1562 625
7 6250 3125 1562 625
8 6250 3125 1562 625

Appendix
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Appendix 2	 Supported Modules

MODEL Name
What are 
supported*

720210 High-Speed 100 MS/s, 12-Bit Isolation Module
720211 High-Speed 100 MS/s, 12-Bit Isolation Module
720220 16-CH Voltage Input Module
720221 16-CH Temperature/Voltage Input Module
720230 Logic Input Module
720240 CAN Bus Monitor Module
720241 CAN & LIN Bus Monitor Module
720242 CAN/CAN FD Monitor Module
720243 SENT Monitor Module
720250 High-Speed 10 MS/s, 12-Bit Isolation Module
720254 4-CH 1MS/s, 16-Bit Isolation Module
720266 Temperature, High Precision Voltage Isolation Module (low noise)
720268 High-Voltage 1 MS/s, 16-Bit Isolation Module (with AAF, RMS)
720281 Frequency Module
701250 High-Speed 10 MS/s, 12-Bit Isolation Module
701251 High-Speed High-Resolution 1 MS/s, 16-Bit Isolation Module
701255 High-Speed 10 MS/s, 12-Bit Non-Isolation Module
701260 High-Voltage 100 kS/s, 16-Bit Isolation Module (with RMS)
701261 Universal (Voltage/Temp.) Module
701262 Universal (Voltage/Temp.) Module (with AAF)
701265 Temperature, High Precision Voltage Isolation Module
701267 High-Voltage 100 kS/s, 16-Bit Isolation Module (with RMS)
701270 Strain Module (NDIS)
701271 Strain Module (DSUB, Shunt-Cal)
701275 Acceleration/Voltage Module (with AAF)
701280 Frequency Module
701281 Frequency Module

The table above includes discontinued modules. When making a purchase, check whether the 
module you want is available with your nearest YOKOGAWA dealer. You can also check the 
information on the YOKOGAWA Web page.
	 https://tmi.yokogawa.com/solutions/products/

* What are supported
:	Conditions can be set from the Combustion Pressure Analysis software.
:	�Conditions cannot be set from the Combustion Pressure Analysis software. 
Measurement is possible using the measurement conditions set on the DL850 
series or SL1000.

:	 The module is not supported. Do not install into the DL850 series.

•	 For a multi-cylinder engine, apply the cylinder pressure signals to consecutive 
channels starting with CH1.

•	 On the DL850 series, install the measurement modules consecutively from the first 
slot, without empty slots in the middle.



App-3IM 720340-02EN

A
ppendix

1

2

3

4

5

6

7

8

App

Index

Appendix 3	 Frequently Asked Questions (FAQ)

This section provides answers to questions frequently asked by users.

Does scaling need to be set on the measuring instrument?

Conversion to physical values is possible on the DL850 series and SL1000, but conversion is 
performed on the Combustion Pressure Analysis Software. As such, use the instrument with scaling 
set to off.

Is it okay to assign labels to the input channels of the measuring instrument?

Channel labels can be assigned on the DL850 series and SL1000, but because the Combustion 
Pressure Analysis Software searches for default channel labels, do not assign channel labels.

The USB license key for the software has been misplaced. Can it be reissued?

The USB license key cannot be reissued even if it is lost. Be careful not to lose it.
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